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1 Introduction
Preliminary topics:
Capabilities

Genera Procedure

Types of Windows

1.1 Capabilities

CRY SCON isagenera crystallographic conversion program, with the following capabilities. See
General Procedure for an overview of themain possihilities.

1) DataEntry. Data can be imported from several popular crystallographic file formats, read in
through a "free-form" fileinput, or entered manually.

2) Tranfor mation of unit cell and atomic coor dinates. Y ou can convert to asub-cell or super-
cell or simply translate to adifferent origin; or any combination of these. When converting to a
sub-cell the positions of presumably coincident or superimposed atoms are averaged, and when
converting to asuper-cell the extrasymmetry-unique atomswhich may be required are generated.
Inany casetheresult isaset of symmetry-unique atomsfor the target cell and symmetry, suitable
for entry into crystallographic software such as Fourier analysis, |east-squares refinement or
structure drawing (Control Window, Transformation Parameters dial og).

3) Changeof symmetry in thesameor different unit cells. Y ou can convert to a sub- or super-
Symmetry group, or even anon-related space group. Asin the case of cell transformation, new
atoms are generated and/or old atoms are averaged as necessary, and the result is a set of
symmetry-unique atomsfor thetarget cell and symmetry (Control Window,

Transformation Parameters dialog).

4) Transformation of anisotr opictemper atur efactor sand atomicvector s (e.g. magnetic
Vectors).

5) Computation of bond lengthsand angles in either the original or transformed structures
(Bond Lengths and Angdles).

6) Conver sion of temper atur efactor s among the different common i sotropic and anisotropic
forms (Export file).

7) Conver sion of atomic par ameter samong sever al different crystallogr aphicdatabaseand
structur erefinement for mats (Export file).

8) Transfor mation of hkl index data, such as diffraction data ( Transformation Parameters
dialog).
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6 CRYSCON Help

9) Computation of powder diffraction intensititiesand simulation of powder diffractograms
(Powder Diffraction).

10) Simulation of precession photogr aphs (Precession Pattern).

11) Expansion of layer s, leaving thelayersthemsel ves unchanged, creating spacein between
(Expand Layers).

1.2 General Procedure

Thefirst step isto enter or import the datafor the crystal to be transformed. To import from one
of several fileformats, choose Import from the File menu. After selecting the format, you will
seethe Import File dialog. The 3-letter file extension ".xxx" in the edit box will be used to filter
thefiles (that is, the Open File dialog will show only thefileswith thisextension). Any changes
you make in file extensionswill be saved for future runs. Some formats may offer a choice of
symmetry option; if thefile actually lists symmetry "as XY Z", that isin the form of the positions
of the general equipoint for the space group in the International Tables for X-ray
Crystallography.

To enter the data manually, choose New from the File menu.

Inthefirst dialog which appears, Title/Axes, supply an 80-character title, and specify the unit-cell
parameters.

Thetwo Symmetry options are Space Group and Custom. The Space Group option lists almost
all standard orientations and origins, so thisisusually thefirst choice. Youcantypeina
Hermann-Maughin or Hall symbol, or givethe International Tables number, but it isnormally
safest to select the space group in the scrolling list and double-click on it or click the Select
button (be sure the symbols/number for the selected group appearsin the edit boxes above). If
you typeinthe H-M symbol, it isinterpreted either according to Volume | of the 1952 edition of
the International Tables, or Volume A of the 1983 edition. The main difference between thetwo
isthat in Volumel the default orientation for monoclinic crystalsisa-axisunique, and in VVolume
A thedefaultisb-axisunique. That is, if you typein"P2/m" the orientation will be different. Of
course to be certain you can also typein thelong form "P112/m" or "P12/m1", or select one of
theseinthelist.

If the space group is anon-standard one, such as C-1 (Charl), it will be necessary to usethe
Custom Symmetry option. Often you can start with the Space Group option and then switch to the
Custom option (ChangeSymmetry Option button) and make modifications as necessary. Inthe
list of operationsyou must supply (if they are not there already), the coordinates of the equivalent
positions of the general equipoint aslisted inthe International Tables, one per line. If the space
group is centrosymmetric and the origin ison acenter of inversion, select the Centric radio
button and supply only half the operations— the center will be supplied by CRY SCON. If the
originisnot on acenter of inversion, you must supply all the operations and select the Acentric
radio button.
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Inthe Input Atom (Site) dialog, supply the standard atomic parameters. Thetypeisnormally the
atomic number, but it could also be an arbitrary number. If thereisonly one occupant of the site
or position it isnot necessary to enter the datain thelist box. If thereis multiple occupancy, click
on Add and supply the parameters as necessary in the Atom Sharing a Site dialog. For a
cell/symmetry tranformation such multiple occupancies are seldom used - they aresimply carried
over for possible Export. Thelabel and type of the main entry will be those of thefirst occupant.

When the atom list is complete you are donewith the"OId" crystal. Theatom listisshowninthe
Control Window. Y ou can savethisfile or document at any time with the Save or SaveAs
optionsin the File menu.

General Procedurefor Cell/Symmetry Tranformation

Now click on the Transform button to specify the parameters of the "New" crystal. Inthe
Tranformation Parameters dialog, click on the Symmetry button if the symmetry of the New
crystal isto be different from the old symmetry. Specify the symmetry asabove. The symmetry
specified here pertainsto the New orientation, not the Old. The default symmetry isthe same as
the Old.

Three types of transformation can be carried out - Trandationonly, I nput atomsonly, and Full
unitcells. Input atomsonly isthe only option which will transform anisotropic temperature
factors and/or atomic vectors (magnetic, displacement, etc.). See Tranformation Parameters for
moredetails.

The parameters specified in the Tranformation Parameters dialog, going downward in the dialog,
correspond to the operations successively carried out by CRY SCON.

First, trandlations may be applied to the input atom coordinates (Pre-symmetrytrandations). If
the origin for your atom coordinates does not correspond to that of the standard symmetry
specified for the Old crystal, corrections must be made here. If you select Translationonly , this
isall that will be done—the remainder of the parameters areignored.

I nput atomsonly option:

CRY SCON appliesthe Pre-matrixtrandations, transforms the coordinates of the Old input
atomsonly, and appliesthe Post-matrixtrandations. (Pre-symmetrytrandations are not
used). Thisgivesaset of input atomsfor the New structure, and the tranformation is compl ete.
Anisotropic temperature factors and atomic vectors are transformed to the new unit cell.

Full unit cells option:

CRY SCON now generates al theatomsin the Old unit cell. If the origin of the New unit cell
differsfrom that of the Old, with respect to the common symmetry elements, you must make
correctionsinthe Pre-matrixtrandations edit boxes. Such differences among sub/supergroups
are common, and it may be necessary to study the diagrams and coordinatesin the Inter national
Tables to get thesetranglations.
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8 CRYSCON Help

CRY SCON now transforms the coordinates according to the matrix supplied. Now it hasthe
contents of the Old unit cell, expressed in coordinates of the New unit cell.

In order to fill out the contents of a supercell, or to shift the contentsfor areorientation,
CRY SCON now systematically adds and subtracts the New unit-cell vectors.

Next, in order to average atom positionsfor a subcell or an increase in symmetry, CRY SCON
similarly adds and subtracts the Old unit-cell vectors. If the position of anew atom generated in
thisway fallswithin the specified distance, or Toler ance, the atomic positions are averaged.

CRY SCON keeps arunning count of the number of atoms averaged in thisway. Thetolerance
should be large enough to avoid having quasi-superimposed atomsin the result, but of courseit
must be less than the smallest bond length in the structure. Setting this may take sometrial and
error. A value of 0.4-0.5 seemsto belarge enough for even rather extreme cases of atomic shifts
in sub/supercells and sub/supergroups.

Post-matrixtrangations may be applied hereif the standard origin for the New space group is
different from that of the Old space group. Thisisan alternative to the Pre-matrixtrandations -
it should not be necessary to use both.

At thispoint, there should be a compl ete and hopefully realistic set of atomsfor the New unit cell.
Depending on the symmetry change, the new set may or may not conform to the New symmetry.
CRY SCON now appliesthe New symmetry to eliminate symmetry-equivalent atoms. Againa
toleranceis applied to decideif atom positionsare "coincident”. Thisgenerates astandard set of
symmetry-unigue atoms, or the"asymmetric unit”. However, in many caseswhen generating a
subcell or increasing the symmetry the averaging process does not put the new atoms exactly on
special symmetry positions.

CRY SCON now appliesthe new symmetry to the supposed asymmetric unit, to generate a
complete set of atomsfor the New unit cell. Y ou should know, based on simplevolume
considerations, how many total atoms are expected in the New unit cell. If the number of atomsin
the unit cell generated in this step does not agree with that generated by transformation (before
symmetry consolidation), CRY SCON now prints out the number it has generated and asksif you
want to recycleto refine the location of atoms on special positions. If the atomsin special
positionswere not |ocated within tolerance (.000177?) in the previous step, extraatomswill be
generated, and the total generated will be greater than expected. If so, "recycling” will repeat the
previous step of reducing to the asymmetric unit, and hopefully averaging will placethe atom
positions closer to the symmetry elements, if not on them (within tolerance). It may take several
cyclesof no changein number before the number of atoms generated comes down to the number
expected. If there appearsto be no improvement after 3 or 4 cycles, inspection of theresultsisin
order - the correction to the atoms in special positions may be obvious, or it may appear that the
matrix and/or trandations are not valid.

When you decline another cycle, the processisterminated and the results appear in aspecial
Output Text or Edit window (see Types of Windows). Thiswindow has a separate menu bar,
with standard entriesfor text editing. Thistext document or output file can be saved separately
from the input data (which isin fileswith extension .cco) using the Save and SaveAs optionin
this menu bar.
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Note that when different input atoms are consolidated during atransformation, for example super-
to sub-cell or on increasing the symmetry, CRY SCON does not attempt to combine the two sets of
occupancies; it smply takesthe list of occupantsfrom the first atom generated.

Inthe Full unit cells option, CRY SCON does not attempt to transform anisotropic temperature
factors; if there are anisotropic temperature factors they are converted to isotropic B'sin the New
structure. Atomic vectorsare not transformed either - the New atomswill have vectorswhich are
simply copied from the first Old input atom which was used to generate the New atom.

To go back to the main datainput, click on the Control Window or use the Window menu to
switch. The process or tranformation can be repeated without removing the Output window, but
its contentswill be replaced. If you want to save successive resultsfiles, use the SaveAsoption
(when the Ouput fileis active or hasthe focus) to give thefile adifferent name (eg myfilel.ccd)
beforerecal culating.

Thetransformed (New) input atoms (Ssymmetry-unique atoms) can be converted into the original
(Old) input atoms with the Transformed to Input option in the Input menu.

Other Operations
There are several thingswhich can be donewithout Transformation. All these operations may be
done on the transformed atoms, aswell asthe original atoms, after atransformation has been

carried out.

Bond Lengths and Angles. The Bond L engths and Angles button in the Control Window will
call up aspecial dialog for this.

Powder and Precession diffraction ssimulation. See the Powder Diffraction and
Precession Pattern dialogs.

Exporting Files. You canwritefiles containing either the Old data or the New datain most of
the same format as are available for import. Select Export in the File menu. In the case of input
filesfor structure refinement programs, such as SHEL X, RIETAN, DBWS/LHPM, etc.

CRY SCON cannot supply al of the required parameters, only the symmetry, unit cell and atomic
positions and temperature factors. Non-essential information such ascommentsisalso not
necessarily passed on, but in most casesthe relevant lines can simply be copied from the import
file (Old crystal) to the export file (New Crystal).

1.3 Types of Windows used in CRYSCON

CRY SCON uses four types of windows besides dialogs and alerts; the Startup window, the
Control window, Text windows and Graphicswindows. 1nWindows, each window hasitsown
menus; in Macintosh, the menus are at the top of the screen. The menus and commandstherein
depend on which type of window isactive.

© 2016 Shape Software



10 CRYSCON Help

When starting up CRY SCON, the menus displayed include only a File menu and a standard Help
menu. Usethe commandsin the File menu or the buttons in the window itself to start anew
CRY SCON data set, or read an old one from afile.

After you have entered or read in the datafor a CRY SCON file, the Control Window opens. This
isactually akind of dialog, but it cannot be dismissed without closing the current dataset. Only
onedataset at atimeisallowed in CRY SCON, and thereis only one Control Window. When this
window isactive, the File Menu has additional commands such as Export, the View Menu has
Powder Diffraction and Precession Pattern options and thereisan Input Menu for datainput and
modification. Notethat the Print, Print Preview and Metéafile optionsin the File menu areinactive
- they are active only when a Graphics window (below) isactive.

The Transform button in the Tranformation Parameters dialog lists the transformed atom
parameters and other data to a separate Text window. The Listing optionin the

Powder Diffraction dialog (File Menu) lists the data to a Text window, as does the

Bond Lengths and Angles dialog (called from the Control Window). When any of these Text
windowsis active, the menu bar contains standard menusfor saving, printing and editing the
contents. Each window actually displaysthe contents of afile, called respectively Powderl.dat,
Powder2.dat and BONDS.DAT. Thesefilesarewritten over again each time the respective
optioniscalled, soif they areto be preserved they should be saved with the Save As commandin
the File Menu, using adifferent name.

The Powder Diffraction and Precession Pattern dialogs (Diffraction Menu) present output in
GraphicsWindows. When a Graphics menu has the focus, the Print, Print Preview, Raster and
Metafile or PICT optionsin the File Menu produce graphics output, essentially what is shown on
the screen. There arefour possible Graphics Windows, for Powder Pattern Old and New atoms,
and Precession Pattern Old and New atoms.

2 Menus and Dialogs

Startup Window Menus

Control Window Menus

Text Window Menus

Diffractogram Windows

2.1 Startup Window
Startup Window (see Types of Windows).

Thiswindow appears when CRY SCON isfirst started, or when a data set
(Control Window) is closed.
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It has its own menu bar, and the following buttons for getting a data file into CRY SCON.

New - Step-by-step input of anew CRY SCON data set.
Open - Open an old CRY SCON datafile.

Import File - Shows apop-up menu with the file types currently supported. This
includes:

---- CCDC FDAT filesfrom the Cambridge Crystallographic Data Centre.

---- SHEL X .INS filesfrom the program system of Prof. G. Sheldrick.

---- CIF - Crystallographic Information Files.

---- DBWS/LHPM Rietveld input files.

---- ICSD Inorganic Crystal Structure Database files.

---- ORTEP Origina or ORTEP Il atom information.

---- XTLVIEW Drawing program.

---- VIBRAT (.MOT) Graphic output filesfrom VIBRATZ.

---- PDB Protein Data Bank files.

---- RIETAN Rietveld program files.

---- GSAS Datafiles (.EXP) filesfrom the Los Alamos L ab system - may include
magnetic vectors.

---- AM MINERAL. Datafilesfromthe American Mineralogist structure data base.
---- FULLPROF. All-purpose refinement program - may include magnetic vectors.
---- Free-form (.inp). Thisallowsinput of atomic coordinates and other information
from almost any source.

---- Ravel ATOMS. This program is not the same as ATOMS by Shape Software, but is
for EXAFSAnaysis.

---- WIENZ2K. This package performs electronic structure calcul ations of solids using
density functional theory (DFT).

Exit/Quit - Quit the CRY SCON program.

2.1.1 File Menu - Startup Window
New - Step-by-step input of anew CRY SCON data set.

Open - Openanold CRYSCON datafile.
Close - Closethe current graphicswindow.
Save - SaveaCRYSCON datafile.

Saveas - SaveaCRY SCON datafile with anew name

© 2016 Shape Software



12 CRYSCON Help

Import File - Shows apop-up menu with the file types currently supported. Thisincludes:

--Free-form(.inp) Thisallowsinput of atomic coordinates and other information from almost
any source.

--CCDC FDAT filesfrom the Cambridge Crystallographic Data Centre.

--SHEL X .INS filesfrom the program system of Prof. G. Sheldrick.

--CIF - Crystallographic Information Files.

--DBWS/LHPM Rietveld files.

--ICSD Inorganic Crystal Structure Database files.

--ORTEP Original or ORTEP Il atom information.

--XTLVIEW Drawing program.

--RIETAN Rietveld programfiles.

--GSAS Datafiles (.EXP) filesfrom the Los Alamos Lab system - may include magnetic
vectors.

--AM MINERAL Datafilesfrom the American Mineralogist structure data base.
--FULL PROF . All-purpose refinement program - may include magnetic vectors.
--ATOMS Atomic structure plotting program (Shape Software).

--VIBRATZ Normal-coordinate calculation program for crystals and molecules (Shape
Software).

--Ravel ATOMS This program is not the same as ATOMS by Shape Software, but is
for EXAFSAnaysis.

--WIENZ2K This package performs el ectronic structure calculations of solids using
density functional theory (DFT).

Quit - Quit CRY SCON.

2.1.1.1 Import Data File
Dialog Box: Import File [ FileMenu]

If thereisadata set in memory which has been modified, you are asked if you want to save the
changes.

If thereis morethan one data set or phase in thefile, the Data Sets...in Import File dialog will
present you with alist. The name of the CRY SCON datafile will be taken from the name of the
file, and thetitle (Control Window or Title/Axes dialog in the Input Menu) will be taken from the
data set or phase. The extension .CCO will be appended to the structurefile.

FileExtension. Thethree-letter extension (.XXX) whichidentifiesthefiletype under Windows
may be specified here - only files of that type will be shown in the Open File dialog. To show all
files, enter " * ",

Sour ceof symmetry (some formats lack thisoption). If you select Use positionsasxyz, in
which symmetry operators are given in theform of positionsin the general equipoint asin the
International Tables, the symmetry option (Input Menu) will be Custom Symmetry. After
import, you may need to check the Symmetry option to be sure the centric/acentric choice and the
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Bravais|attice type are correct (some formats include a center of inversion and/or lattice
centerings in the operators and some do not). If you select Spacegroup symbol, the

Space Group symmetry option will beused. The Hall symbol, the Hermann-Maughin symbol,
and then the International Tables number will be used in that order if present. If you select Use
positionsasxyz and the information on operationsis not present, the symmetry option will default
to Spacegroup symbol. The H-M space-group symbol, Hall symbol, and space-group number
areawaysread if present.

If symmetry is present inthe "xyz" or operation form, thisisusually the safest option However,
this option does not give information on systematic extinctionsor true d-spacings, which are
required for the Powder and Precession options. It isusually possible to derive the correct space-
group symbolsfrom the operations using the Get Symbol optioninthe Custom Symmetry dialog.

Atom types (someformatslack thisoption). If adistinct atom type number is not present in the
input, CRY SCON will try to assign an atomic number to each input atom either from the first one
or two characters of the atom label itself, or from a separate atom type label if that is present. In
diffraction refinement fileformats, this separate atom type label typically identifiesthe scattering
factor, and it may be a matter of operator preference whether this or the atom label (if either) will
identify theelement.

Note that in the case of multiple atoms with the same coordinates, that is multiple occupanciesfor
asite, CRY SCON consolidates them into one input atom, but preservestheinformation on the site
occupants(see Input Atoms).

Filetypes supported, with the default extension:
**** Free-Form - .inp. Thisimportsfilesin the free-form format described el sewhere

Atom Parameter Files). Note that thisformat has been expanded, so that essentially all relevant
datafor acrystal may be entered.

**** CCDC (Cambridge Crystallographic Data Centre) FDAT - .fdt. Thefilesnormally
contain aunique set of input atoms, which are the same as those required for input of acrystal in
CRY SCON, plusin many cases some extra symmetry-derived atoms necessary to completethe
molecule; CRY SCON will use only the unique set of atoms, omitting the extra ones.

***x% SHEL X-93 - .ins. CRY SCON is programmed only for SHEL X-93 files, although it may
also be possible to read SHEL X-76 files.

Symmetry . The Custom Symmetry option will be used. Typically the true space-group symbol
can berecovered from thetitle. CRY SCON will read the SYMM linesin the SHELX fileonly if
they arein standard International Tables format - the translational part must precede the
positional part (i.e. 1/2+x, not x+1/2). If the symmetry was copied from the Tables, there should
be no problem. Y ou can edit the symmetry operators after they areread in.

FRAG instruction. Atomslisted between thisinstruction and the FEND instruction will be
ignored.
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14 CRYSCON Help

RESI instruction. Atomslisted after thisinstruction will beincluded, but not treated in any
specia way.

Hydrogen atoms. SHEL X has several sophisticated ways of locating hydrogen atomswhich are
not duplicated by CRY SCON. Freguently, the positions of the hydrogen atoms are not in the
INSfile, and must be taken from the output. The output lines giving the hydrogen positions can
be copied into the .INSfile. If thisisdone, atype or SFAC number must be inserted after the
label and before the coordinates. The hydrogen lines can also be put into a separate file and read
inwith the SHEL X +filename include-fileinstruction.

Most of theinstructionsina SHEL X filewill beignored. However, CRY SCON may not know
al the current instructions. If it cannot identify an instruction, it triesto read the line as an atom
line (thisistheway SHEL X works). If thisfails, you are asked if you want to add the first four
letters of thelineto thelist of instructionsto beignored. Theseinstructions-to-be-ignored are at
the end of the SCRPTR setup file, separated by spaces and preceeded by the number of
instructions. Y ou can edit thislist if necessary.

****% CIF (Crystallographic Information Files) - .exp. CRY SCON usesonly asmall number
of the possible dataitemsin a CIF file and recovers only the most basic information. The
dictionary file, CIFDIC.SHT (ashortened version of the complete CIF dictionary), must bein the
home directory (the directory containing the CRY SCON.EXE file). CRY SCON will read
macromolecular (mmCIF) files, and if the crystal-to-Cartesian transformation matrix in theform
of _atom_sites.fract_trans matrix lines, CRY SCON will set up its own matrix so that the
Cartesian coordinates may be converted back to fractional coordinates on the crystal axes. See
below under PDB filesfor further details of Cartesian to crystal transformations.

**** DBWSLHPM Rietveld - .dbw/.lhp. The DBWS and LHPM formats are very similar.

Inthe Atom typenumber sfrom: box, the Typelabel optionwill select the NTY Pfield which
usually containsthe elemental symbol for recovery of the scattering factor.

Three different versions of DBWSfile are recognized: 9002, 9411 and 9807. Tryingtoread a
9002 file may cause an error on thefirst pass, as CRY SCON triesto read according to the later
formats, and in that case you will have another chance to read again according to the 9002 format.
Fileswith only one phase are more likely to beread correctly (but please report any problems
reading valid DBWSfiles).

***% |CSD (Inorganic Crystal Structure Database) - .ret/.cry. Threetypesof ICSD fileare
supported:

1) Filesfrom the current CD-ROM database, accessed by the program RETRIEVE. The
RETRIEVE files must be written from the DATA window using the PRINT option, not as export
files(if thereis sufficient demand, export files may be supported). That is, thefile should bea
copy of what is shown on the screen in the RETRIEV E program.

2) Filesfrom the Canadian Scientific Numeric Database System (CAN/SND). This service may
no longer be available. Thefilesarereferred to as CRY STIN.
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3) Filesintheorigina CRY STIN format (or closetoit), available from the Netherlands CAOS
information system, from ETH (Switzerland) and perhaps other sources. Thesefilesarealso
referred to as CRY STIN.

Please contact Shape Softwareif you have | CSD files which cannot be read by one of these
options. The best procedure isto send samples of the filesby email or an afloppy diskette.

In CAN/SND files, CRY SCON will usethe"NA:" linefor thetitle; in RETRIEVE and original
CRYSTIN files, CRY SCON will usethefirst "MINR" lineif present, otherwiseit will usethe
"NAME" line.

**** ORTEP - .ort. Thisimportsthe unit-cell parameters, symmetry, atomic positionsand
thermal datafrom original or ORTEP I files. It does not read the boundary and plotting
instructions.

*xxx XTLVIEW - xtl. CRY SCON may need to shift the fractional coordinates to insure that
theoriginisplaced on acenter of inversion.

**** FEULLPROF - .exp. The"User-supplied' non-magnetic and magnetic options (JBT = +-4
or +-5) are not directly supported - crystallographic and magnetic parametersin files using these
optionswill beread asif one of the standard options were used. Magneticinformation isaways
read as vectorsin the crystall ographic axes (not as polar or other coordinates), and FULL PROF-
specific magnetic symmetry isnot currently used.

***x American Mineralogist StructureDatabase- .amc. The American Mineralogist structure
databaseis currently available on the Internet at www.geo.arizona.edu/xtal-cgi.test. Thismay
change, but the database should be | ocatabl e by searching for American Mineralogist.

***x% GSAS - .exp. The General Structure Analysis System (Los Alamos) can give magnetic
moment vectors.

**** RIETAN - .xyz. Thisformat gives complete symmetry operations, including a center of
inversion and lattice centeringsif present, as numeric matrices. CRY SCON will convert the
matricesto "xyz" form and use the Custom Symmetry option. It will also attempt to identify the
center of inversion and | attice centerings and will remove them with your approval.

***x% ATOMS (Shape Software) - .str. CRY SCON will read and store data on atom colors and
radii from thesefiles. Such datawill bewritten into free-form (.inp) files when exported, and can
then be read back into ATOMS.

***% VIBRATZ (Shape Software) -.vbr. CRYSCON will read the main datafiles (.vbr) from
theWindowsversion.

**** PDB - .pdb. PDB filesare intended primarily to present data on protein structures
as molecules, and the atomic coordinates are always given in Cartesian form. However,
CRY SCON can use the information in the SCALEN lines (Cartesian to crystal
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transformation matrix) and the CRY ST1 line to recover the fractional coordinates and
space-group symmetry for the original crystal, through the CRY SCON transformation.

In some cases thisinformation is not present - if it is present you will be asked if you
want to import the matrix. Note that the transformation matrix given in the SCALEn
linesis sometimes not sufficiently precise (because of limitation to 6 places after the
decimal point) to recover the original unit-cell parameters (asgiveninthe CRYST11ine)
precisely. The cell parameters derived by CRY SCON for the new crystal are those
derived from the transformation matrix, not from the CRY ST1 line. After importing, you
should check the cell parameters and correct as necessary.

The transformation matrix isimported into the Transformation dialog, and the space
group for the crystal will be that for the new crystal. Theold "crystal” will have the
origina Cartesian atomic coordinates, and space group P1. Inthe Transformation dialog,
specify the transformation type as Input Atoms Only, so that CRY SCON will not try to
fit the original atomsinaunit cell (if you specify Full Unit Cell there may be no generated
atoms, asthe "unit cell" isonly 1 Angstrom on aside.

The Input Atoms Only option will not try to generate the atoms in the New unit cell, or
try to check whether all atoms are symmetry-unique. If redundant atoms are present, a
further cycle may be necessary. In the Control Window, click the New to Old button,
Then Transform. The matrix for this step should be the unit matrix, and the symmetry for
Old and New should be the crystal symmetry, that isthe symmetry for the original crystal.
Use the Full Unit Cells option.

**** RAVEL ATOMS- .inp. Thisprogram isnot the same as ATOMS by Shape
Software, but isfor EXAFS Analysis.

***x WIEN2K - .stw. The program package WIEN2k performs electronic structure
calculations of solidsusing density functional theory (DFT). CRY SCON will read the
struct input files, but will only recognize file extensions with three characters, so it may
be necessary to rename thefiles, search manually in the File Open dialog (enter *.struct)
or usethe"all files' option. Somefiles may have the space-group number and symbol,
but the orientation may be ambiguous and Use positions as xyz should normally be
selected in the Import File dialog.

**xx%x | ZA (zeolites) - .iza Filesfrom the International Zeolite Association database.

2.1.1.2 Data Sets in Import File

Dialog Box: Data Sets...in Import File [ Import File Command - File Menu |

When you open an Import File, CRY SCON will search throughiit to find all the data setswithin
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it, uptoalimit. If thereis morethan one data set, thisdialog will present you with alist. The
name of the CRY SCON datafilewill betaken from the name of thefile, and thetitle

(Control Window, or Title/Axes dialog inthe Input Menu) will be taken from the data set, phase
or crystal selected. The extension .cco will be appended to the structurefile.

2.1.1.3 Importing mmCIF files

The CIFfilewasoriginally designed to transmit crystallographic structureinformation. The
mmCIF fileisavariant which transmits data on macromol ecul es using atomic coordinates on
Cartesian axes, not fractional coordinates on crystallographic axes. In thisform, the data are not
usable by CRY SCON.

However mmCIFfilesusually have theinformation necessary to transform the coordinates back to
crystallographic axes. The Cartesian-to-crystal transformation matrix isin lines of thetype

_atom_sites.fract_transf_matrix[1][1] 0.023496

which make up a3 x 3 transformation matrix, plustrandations. The parameters may or may not
beina"_loop".

Thisistheinverse of the required matrix for CRY SCON. If the axes are orthogonal
(orthorhombic, tetragonal, cubic systems), the off-diagonal elementsare zero and the diagonal
elements of therequired matrix aresimply theoriginal crystallographic axislengthsthemselves,
whicharegiveninlineslike

_cell.length_a 42.560

The coefficients of theinverted matrix may be entered directly into the

Transformation Parameters dialog. The transformation should be on "Input atoms only",
otherwise CRY SCON will reject the original generated atomsasnot being intheunit cell. The
result will be aset of atomsfor acomplete molecule, with atomic coordinates on the
crystallographic axes. Some of these atoms may be redundant in the original crystal symmetry,
whichmay begiveninthemmCIFfileinlineslike

_Symmetry.space_group_name_H-M 'P43212

If thereissufficient interest in using mmCIF in crystallographic (not molecular) form, the
capability to transform automatically can be added to CRY SCON.

2.1.1.4 Import IZA file
Import 1 ZA (International Zeolite Association) File [File menu]

See the Import File dialog for general aspects of importing atomic-structure datafiles.
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The IZA has an extensive database of natural and synthetic zeolites available on the WWWeb,
but does not seem to have an option for export of the data - it will be necessary to cut-and-paste
the information into a text file.

Go to the Web page for the Database:

http://www.iza-structure.org/databases/

and select "Collection of Simulated XRD Powder Patternsfor Zeolites". Thisshould
show amatrix of structure types by three-letter code - select one of these. Y ou can also
access structures in other ways, but you need to end up on a page showing options for X-
ray powder diffraction together with the structure data. There should be linesfor
"Material name" ..."Composition:" ... "Crystal Data:" and others, with the fractional
coordinates for the atomsin atable.

Mark the top right part of the page with your mouse, starting with the three-letter code
centered at the top, and going below the atomic-coordinates table. Do not include the
"Reset" and " Submit" buttons and material below thisline. Do not include the column of
options on the | eft of the page. Copy the marked information into the clipboard in the
standard way.

Now, in aword processor, open anew text (ascii) file. Paste the clipboard contentsinto
thefile. Savethefile, givingita".iza" extension if possible. Hereisasample (or look in
the ZEOLITES subfolder for sample..izafiles):

LAU

Material name: Launontite

Conposi tion: | Ca4(H20) 18| [Si 16Al 8)I48]

Refined conposition: | Ca4(H20) 18| [Si 16Al 8]48]

Crystal data: Space group: Cl2/nil (# 12)
a= 14.8538 A b = 13.1695 A c = 7.5421 A

al pha = 90° beta = 110.323° gamm = 90°

X-ray Rietveld refinenent, Rwp=0.115, Rp=0.090, RF2=0.046
Comment: unique axis b, cell choice 1
Ref erence: Artioli, G and Stahl, K
Zeolites, 17, 249-255, (1993)

At omi c coordi nates Atom nane Form factor x y z PP B(iso)

CA Ca 0.2601 0.5 0.737 1.0 3.4

SI1 Si 0.2368 0.3838 0.156 1.0 1.89
SI2 Si 0.0763 0.3834 0.325 1.0 2.13
AL1 Al 0.1315 0.3080 0.737 1.0 2.61
0L 0 0.260 0.5 0.219 1.0 0.79

2 O 0.2084 0.3744 0.919 1.0 1.66
3 O 0.1384 0.3838 0.552 1.0 0.55
>4 O 0.146 0.3454 0.203 1.0 2.92

G O 0.3205 0.3185 0.248 1.0 0.79
06 O00.043 0.5 0.267 1.0 0.71

Or O 0.013 0.3083 0.743 1.0 2.53
H20L 2-(H2O) 0.029 0.171 0.0 0.5 2.45
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H22 - (H20) 0.401 0.5 0.026 1.0 5.92
H206 C2- (H20) 0.5 0.467 0.5 0.5 3.16
H208 - (H20) 0.1426 0.129 0.332 1.0 4.03

2.2 Control Window

Thiswindow, which has controlslike adialog, is present whenever adataset isin memory. It
liststhe input atoms and allows easy modification of them and access to the main operationsin
CRY SCON.

The Symmetry button allows specification or modification of the current symmetry for the
original or old atoms - it calls up the Symmetry dialog, if an option has not been selected, and
either the Space Group Symmetry or Custom Symmetry dialogsif the option has been selected.

The Transform button brings up the Transformation Parameters dialog, which allows
specification of the parametersfor the new crystal. The unit-cell and atomic coordinates of the
new crystal are displayed in an output text window whichiscalled from the

Transformation Parameters dialog. If you want to carry out certain operations on the old crystal
only, such as Export (File menu), Powder Diffraction or Precession Patterns (Diffraction Menu
menu), it isnot necessary to Transform.

The Expand L ayer s button brings up the Expand Layers dialog - thiswill expand acrystal
structure on certain planes, increasing the length of the selected axis, but leaving the actual short-
range dimensions of most of the structure (bonds, etc. within layers) unchanged.

The New to Old button will replace the current Old or input atoms, cell and symmetry with the
the New or transformed atoms, cell and symmetry. Y ou will have the option of saving the current
fileand assigning anew name to the transformed data.

Thelargelist window givesthe current Old or original input atoms, which can be modified or
deleted with the buttons below thelist. Atoms can also be modified by double-clicking onthe
selection, which bringsup the |nput Atom (Site) dialog.

CRY SCON listsonly distinct atomic positions, or sites, in thisdialog. These sites may have
multiple occupants, which arelisted in the Input Atom (Site) dialog. The site occupancy (SOF)
for each input atom shown in thisdialog is the sum of theindividual occupancies, which can be
accessed through the Input Atom (Site) and Atom Sharing a Site dialogs.

B(equivaent) isequal to Biso or derived from Uisoif the siteisisotropic, or calculated according
to the formulabelow for anisotropic sites.

Beq = 2pi"2 (1/3) Sum(i) Sum(j) U(ij) a (i) a () A(i) A()

where a*'s are thereciprocal axislengthsand A's are the direct axislengths.
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The Bond L engths/Angles button brings up adialog allowing cal culation of bond lengths and
anglesfor all atoms or aselected atom - you can choose either the old or new crystal.

2.2.1 Input Atom (Site)
Dialog Box: Input Atom (Site) [ Control Window ]

L abel. Each atom may be assigned alabel of up to 6 characters. Labelsin CRY SCON may not
contain any embedded blanks. Any embedded blanksor leading blanksin labelsinimport files
will be converted to underscores. Trailing blankswill be stripped.

Fractional coordinates. For crystals, thex ,y and z coordinates should bein fractions of the
unit cell.

Type. Itisusually expedient to enter the sametypefor all atomswhich are bonded similarly (e.g.
all carbons, al silicons, al six-coordinated cations, all oxygens, etc.) to save effort in defining
bonds and polyhedra. The atomic number can usually be used for the type, athough there are
situationsin which different type numbers should be used for the same element.

In atransformation, if atoms are found to be superimposed the type and other parameters are
simply taken from the initial atom generated in thisposition. Thusif it isknown that atoms are
going to be consolidated, for examplein asuper- to sub-cell transformation, it may be agood idea
to use asingletypefor those which will be consolidated.

Any changeinthe Label or Type for the site will be transmitted to thefirst site occupant.

Thelist box givesthe current occupants of the site. To modify individual occupants, double click
on the selection or click the Revise button.

Inthe TemperatureFactor group, the type number asused in ORTEP must be specified. The
temperature factors are given below (in abbreviated form). The common type numbersare given
in the dialog; other types are rarely used nowadays. Supply the b, B or U double-subscripted
coefficientsasrequired - intype O, the b coefficients are usually called betas. If thetypeis
isotropic, the singlevalue (B or U) isgivenin the (11) box.

ORTEP Typesof TemperatureFactors

TypeO - e’(-b11h"2...+2b12hk...) *** Betaaniso

Typel - eM-b11h™2...+b12hk...)

Type 2 - 27(-b11h"2...+2b12hkK...)

Type 3 - 2°(-b11h"2...+b12hk...)
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Type4 - eN(-.25(a* "2B11h2.. +2a* b*B12hk...)) *** B aniso
Type5- eN(-.25(a* "2B11h"2...+a* b* B12hk...))

Type 6 - ISOTROPIC - e(-B(sin(theta)/lambda)*2) *** B iso
Type 7 - sphere of arbitrary radius

Type8- eN-2pit2(a* "2UL1 2. +2a b U12hK...)) *** U aniso
Type9- eN(-2pir2(a* "2U11h 2. +a* b* U12hk...))

Type 10 - ISOTROPIC - e’(-2pi~2U(sin(theta)/lambda)*2) *** U iso (not astandard ORTEP
type)

2.2.2 Atom Sharing a Site
Dialog Box: Atom SharingaSite [ Input Atom (Site) diaog ]

Thisliststhe propertiesfor each occupant of asite.

Site occupanciesin CRY SCON do not include space-group multiplicitiesand the total for afully-
occupied site should be 1.0. If Import or Export filesinclude multiplicitiesCRY SCON should
convert asnecessary.

The Type and SiteOccupancy will be used in theintensity calculationsfor Powder or Precession
patterns. For this purpose, the type number should be avalid atomic number, unlessthe
SCATFAC.DAT file(containing the scattering factors) ismodified.

Any changeinthe Label or Type of thefirst occupant will be transmitted to the main entry for
thesitein the I nput Atom (Site) dialog.

The Element, Charge and ScatteringNumber are parameters specific to someimport/export file

types, and are not used by CRY SCON. They may not be meaningful unlessthe dataiis exported
in the sameformat in which it wasimported.

2.2.3 Bond Lengths and Angles
Dialog Box: Bond Lengthsand Angles [ Control Window |

This suppliesthe parameters for the computation of thelist of bond or interatomic distances and
angles centered on one or al of theinput atoms. Y ou can select either origina (Old) or
transformed (New) atoms. Theradio buttons determine whether distances and anglesare
computed for al input atoms or only the one currently selected in the Control Window or in the
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edit box.

Only 36 atomsin addition to the central atom are allowed, so the distancelimit for central-
ligand should normally not be more than about 4 Angstroms. Anglesare only calculated for
ligand pairs at less then the ligand-ligand limit; if you want to determine anglesfor atomson
opposite sides of the central atom, the ligand-ligand limit should be twicethe central-ligand limit.

Theresults of the distance and angle calculations are written to afile called either Bondsl.ccd
(original atoms) or Bonds2.ccd (transformed atoms) in the home directory (see

Files used by CRY SCON), and then shown in a Text window (see Types of Windows ). This
window hasits own menusfor editing and saving thetext file. From this Text window, return to
the Control window and the ordinary operating mode of CRY SCON by clicking in the Control
Window, or with the Window menu.

Errorsin bond lengths and angles are not calculated by CRY SCON. Thisis because sufficient
data are seldom available for accurate calculation - it would be necessary to have the complete
variance-covariance matricesfor both the unit-cell and atomic-parameter refinements. The
difference between the correct error values and those cal culated using only the standard deviations
of the parametersisusually not large, but discrepancies between valuesin the origina
publications and those cal culated by CRY SCON could create confusion.

2.2.4 Expand Layers
Dialog Box: Expand Layers [ Control Window ]

Thisoption will expand acrystal structure on certain planes, increasing the length of the selected
axis, but leaving the actual short-range dimensions of most of the structure (bonds, etc. within
layers) unchanged. It operatesoninput atoms(original crystal), leaving the symmetry unchanged.

Any atomswhich are exactly on the expansion plane (for example K atomsin amicastructure)
will remain on the expansion plane, and thus bonds from these atoms to other parts of the
structurewill belengthened. Bonds connecting structural layerswill also be lengthened.

The Expansion factor isthe amount by which the selected axisisincreased. For example, if the
c-axisis 10.0 Angstroms before conversion, an expansion factor of 1.5 will changeit to 15.0
Angstroms.

Expand on axis. Thisselectsthe axisto be lengthened. Fractional coordinates of most atomson
thisaxiswill be changed. The other two axes, and fractional coordinates on these axes, will be
unchanged.

Number of planes. Thereare often several symmetrically identical planes cutting the selected
axis. For example, there may beidentical mirror planesat 0.0 and 0.5. Y ou must determine this
number from examination of the space-group symmetry.

Expand at zero. There may be achoice of location of the expansion planes. Normally thiswill
be a choice between the set of planes at fractional coordinate zero (on the expanded axis) and
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another set at somerational fractions. For example, if the Number of planesis 2, there may be a
set at 0.0 and 0.5 and another at 0.25 and 0.75. If the Expand at zer o box is checked, the
expansion will be at the first set.

At the moment an arbitrary location of the expansion planeisnot supported, and for low-
symmetry crystals, or those which have a choice of more than two locations, it may be necessary
to adjust all coordinates so that the expansion planeisat zero. If thissituationiscommon,
support for arbitrary location will be added.

Tolerance. Thisisused to decideif an atomisexactly on the expansion plane, in which caseits
coordinate on the expansion axiswill not be changed - that is, it will remain exactly on this plane.
Toleranceisinfractional coordinate units (not Angstroms). If you want atomswhich are exactly
on the expansion planeto remain in continuity with the remainder of the structure, their fractional
coordinates on the expansion axis should be changed by greater than the tolerance. Usually this
will result in duplication of the atoms.

2.2.5 File Menu - Control Window
New - Step-by-step input of anew CRY SCON data set.

Open - Openanold CRYSCON datafile.

Close - Closethe current graphicswindow.

Save - SaveaCRYSCON datafile.

Saveas - SaveaCRY SCON datafile with anew name

Import File - Showsa pop-up menu with the file types currently supported. Thisincludes:

--Free-form(.inp) Thisallowsinput of atomic coordinates and other information from almost
any source.

--CCDC FDAT filesfrom the Cambridge Crystallographic Data Centre.

--SHEL X .INS filesfrom the program system of Prof. G. Sheldrick.

--CIF - Crystallographic Information Files.

--DBWS/LHPM Rietveld files.

--ICSD Inorganic Crystal Structure Database files.

--ORTEP Original or ORTEP Il atom information.

--XTLVIEW Drawing program.

--RIETAN Rietveld programfiles.

--GSAS Datafiles (.EXP) filesfrom the Los Alamos Lab system - may include magnetic
vectors.

--AM MINERAL Datafilesfrom the American Mineralogist structure data base.
--FULL PROF . All-purpose refinement program - may include magnetic vectors.
--ATOMS Atomic structure plotting program (Shape Software).

--VIBRATZ Normal-coordinate calculation program for crystals and molecules (Shape
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Software).

--Ravel ATOMS This program is not the same as ATOMS by Shape Software, but is
for EXAFSAnaysis.

--WIEN2K This package performs el ectronic structure calculations of solids using
density functional theory (DFT).

Export File - Thiswill write unit-cell, symmetry and atomic-coordinate information in most of
the Import formats above.

Quit - Quit CRYSCON.

2.25.1 Export Data File
Dialog Box: Export DataFile [ FileMenu]

Y ou have the choice of exporting the original (Old) or transformed (New) data. Note that the
transformed datais not otherwise saved except in the .ccd filewhich iswritten on transformation,
although it can berecal culated easily enough.

Most of the import/export formats supported by CRY SCON fall into one of two categories,
archival formats and refinement formats. The archival formats, such as CIF, ICSD and CCDC
tend to give only basic crystallographic information, including space group, unit cell parameters,
atomic coordinates and thermal parameters. The refinement file formats, such as DBWF, SHEL X
and GSA S generally contain much moreinformation, such as scattering factors, weighting factors
and refinement flags. CRY SCON generally cannot provide all thislatter information, and it
cannot be expected that arefinement-format file written by CRY SCON will be successfully read
in by the target refinement program (e.g. DBWF, SHEL X or GSAS) without many additions and
even some editing of thelineswhich arewritten by CRY SCON, since even theselines may contain
somerefinement-specific data.

Space groups symbols may be written in many ways, for example space group number 116: P-
4c2; P-4c2; P_-4_c_2; PA-c2. CRY SCON does not generally change the symbol - it isusually
exported in the form it was imported or entered. The Sginfo routines used by CRY SCON can
interpret many of the variations, but export target program may not be able to interpret some
forms, and it may be necessary to edit the space group symbol after exporting afile.

Y ou can convert the type of the temperature factors, e.g. from beta'sto U's; and/or you can
convert from isotropic to anisotropic and vice versa. Of course not all export formats allow a
choice. If the Keep current form radio button is checked, the current temperature factorswill be
kept, if possible. However, the export format may not support the current form, in which case
the temperature factorswill be converted to atypewhich is supported.

The equivalent isotropic temperaturefactor, if converting from anisotropic to isotropic, will be
computed according to theformula:

Beg = 2pi”2 (1/3) Sum(i) Sum(j) U(ij) a* (i) a (j) A(i) A(j) wherea*'sarethereciprocal axis
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lengthsand A'sare the direct axislengths.

If the Removemultipleoccupancies box is checked, only asingle atom will bewritten for each
site, using the relevant datafor thefirst atomin the list of occupants. If not, in most file formats a
new atom will be written for each site occupant - that is, the number of atomsin the export file
will be larger than the number of siteslisted by CRY SCON.

Note that when different input atoms are consolidated during atransformation, for example super-
to sub-cell, CRY SCON does not attempt to combine the two sets of occupancies; it simply takes
thelist of occupantsfrom the first atom generated.

2.2.6 Input Menu

Title/Axes - Input of the 80-character title, selection of crystal system and specification of unit-
cell parameters

Symmetry - Selection of space-group or custom symmetry

2.2.6.1 Title/Axes
Dialog Box: Title/Axes [ Input Menu ]

Thetitle may have up to 80 characters of identifying information.

Y ou should supply the axis lengths and interaxial angles appropriate to the crystal system you
selected. Axislengthsshould bein Angstroms, and anglesin degrees and fractions (not minutes
and seconds).

Although standard crystall ographic nomenclature givesthe sameletter (usually a) to symmetry-
equivalent axes, after theinitial input CRY SCON may call all axes, whatever the system, "a, b,
and c" and angles"Alpha*, "Beta' and"Gamma'.

2.2.6.2 Symmetry
Dialog Box: Symmetry [ Input Menu - Control Window - Transform Dialog |

The authority and source of information for crystal symmetry isnormally the International
Tables for X-ray Crystallography . However, any space-group symmetry may be used for the
atoms. Therearetwo optionsfor selecting or entering symmetry information.

Space group from table - Choose a space group by symbol or number.

Custom Symmetry (xyz) - Enter al theindividual operations asfractional x,y,z coordinatesin
theunit cell.

Each choice calls up asub-dialog.
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2.2.6.2.1 Space-Group Symmetry
Dialog Box: Space Group Symmetry from Table [ Symmetry dialog ]

Space-group symmetry isobtained using licensed excerpts from the SGinfo program of Ralf
Grosse-Kunstleve.

Y ou can specify the space group in any of threeways: 1) the Hermann-Maughin (H-M) or
International symbol; 2) the Hall symbol (S.R. Hall: ActaCryst., A37, 517, 1981); or 3) the
number of the group in the International Tables for X-ray Crystallography .

International TablesVolume. Y ou have the option of using the older version of the Tables
(calledthe Second Edition : various revisions and reprints from 1952 to 1979) in which the
symmetry information wasin Volumel, or the newer version (1983 onwards) in whichitisin
VolumeA. Theprincipa difference between thetwo versionsisthat in the older onethe unique
axis of amonoclinic group isassumed to be the c-axis, whereasin the newer oneit isassumed to
bethe b-axis. Thusentering the symbol P2/m givestwo different orientations depending on the
volume selected. Y ou can aways specify the orientation by entering the long form of the symbol,
e P2iml11,P12/mlorP112/m.

TheH-M or Hall symbol can be typed into the appropriate edit box in either short form or long
form, with or without spaces between positions. However, it isusually safer to select the symbol
from thelist box at the bottom, which givesthe standard-form symbolsfor all the space-groups.
Clickingthe Select button copies the relevant data to the edit boxes at the top; it does not actually
generate the symmetry. Symmetry generation isdone after you click OK - thismay take afew
seconds.

If the space group you select does not appear to be consistent with your choice of axes, awarning
box appears, but in most cases consistency isnot required. However, if you selected trigonal
rhombohedral axesinthe Title/Axes dialog, only arhombohedral space group may be sel ected.
Thisisdone by adding :R to the end of the symbol in the case of H-M symbols, or asterisk (*) in
the case of Hall symbols. If you select the rhombohedral setting and then switch to the

Custom Symmetry option, the lattice type will be P; it will be R if the axes are hexagonal .

Origin of coordinates. Inthe International Tables, 24 space groupsin the orthorhombic,
tetragonal and cubic systems are given with achoice of origin: 1) not on acenter of inversion or 2)
on acenter of inversion. Thesetwo originsare selected by adding :1 or :2 respectively to the end
of the H-M symbol or the number. Although the origin on the center is second in the Tables and
inthelist, if the number isomitted thiswill bethe default. Thisdifferenceinoriginisexplicitin
the Hall symbol, and other choices of origin may be specified for any space group with the Hall
symbol. Note also that the origin may be shifted before transformation (see

Transformation Parameters).

2.2.6.2.2 Custom Symmetry
Dialog Box: Custom Symmetry [ Symmetry Dialog |

CRY SCON can access al the standard orientations for space groupsin the International Tables
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but there are still afew possibilitiesfor aternate settings of symmetry elementswith respect to
structure axes which are not listed in the Tables . In some cases displacement, rotation or
permutation of atomic coordinates may not be convenient, and it may be easier to enter the
symmetry operationsfor the non-standard setting. These are sometimes given in reportson
structures (e.g. Wyckoff, Crystal Structures). Note however that often only the operationsfor
specia positionsare given: CRY SCON needsall the operationsfor the general position.

Some | mport formats do not give a space-group symbol, and symmetry is supplied in the form of
operations as xyz, or as actual numerical matrices. CRY SCON converts numerical matrices to
xyz form.

The Symboal is not used by CRY SCON for transformations, unless you switch to the

Space Group Symmetry option. However, the Powder and Precession optionsrequireavalid
space-group symbol - they must use the symmetry from the symbol rather than the custom
symmetry.

Get Space Group Symbal. Thisbutton will attempt to identify the space group from the
operations, the | attice type and the centric/acentric setting. If the operations contain an inversion
center or | attice centerings, CRY SCON should identify them and they can be removed at your
option. Clicking the ChangeSymmetry Option button will automatically causes an attempt to
identify the space group.

If you specify Centric, rather than Acentric, you must enter only half of the symmetry operations
(asgiveninthe International Tables), related to any others by the center. The two sets or halves
of the operationsrelated by the center will have opposite signson the x, y and z coordinates. The
Centric choiceimpliesthat the origin of coordinatesison acenter of inversion. If the space group
isactually centric, but the origin is not on acenter, select Acentric and enter al the operations.
Note that for atransformation the atoms can be shifted (Pre-symmetrytrandations) in the
Tranformation Parameters dialog, to placethe origin either on or off aninversion center.

The Bravaislatticetype isin most casesthe capital letter which begins the space-group symbol.
However, CRY SCON uses asomewhat different convention from the standard for trigonal
crystals: if you are using hexagonal axes for arhombohedral crystal (whose standard space group
symbol will always beginwith"R"), enter "R" - if you are using the primitive rhombohedral
axes, enter "P".

Inthe Oper ations group, you must enter all the"symmetry operations’ for the most general
position in the structure. Click onthe Add Line button to add aline, Delete to remove one. Note
that there should be only one operation per line. Enter or edit thelinein the edit box to the right of
thelist.

2.2.7 Diffraction Menu

Y ou can do Powder diffraction, either asadiagram or alisting, or a Precession pattern.

The Font item in thismenu will set thefont for thelegendsin the diagramsaswell asthelettering
for theindicesin the powder diagram.
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Thefont for the powder listing, shown in a Text Window, is set in the Window Menu of the the
Text Window.

2.2.7.1 Powder Diffraction

Dialog Box: Powder Diffraction [ Diffraction Menu ]

Y ou can compute the pattern or list for either original (Old) or transformed (New) atoms and unit
cell.

If youselect aLigt, thelist will appear in a Text window (see Types of Windows). Therewill be
alineinthelisting for each crystal form, or symmetry-unique set of reflections (with center of
inversion assumed). If thereismorethan onewavelength, the 2-thetaand relative intensity will be
listed for eachin that line.

If you select a Graph, you may show either Bars or a Curve - the curve will use Gaussian lines
with the selected full width at half maximum (FWHM). For acurve, thelocation of individua
reflections will be shown as ashort bar underneath the curve.

The Linewidth pertainsto the width of al lines or "pen strokes" in the graph, not the width of
each spectral peak (FWHM).

If the Vertical scalefactor or magnification is 1.0, the strongest peak will just fill the plot area.
If you want to see more detail in the weaker reflections, thisfactor can beincreased and the
stronger reflectionswill betruncated.

If the atom records include temperature factors, they will be used. If an atom has no temperature
factor, the B isotropic value in the Default temper atur efactor box will be used. No absorption
or extinction correctionsare applied.

Scattering factors used by default are those for neutral atoms from Volume 4 of the International
Tables (1974) edition. Atom type numbers must be atomic numbers, or must correlate with the
order of theentriesin the SCATFAC.DAT file. Thisfilemay be edited to supply different
scattering factors (see Files Used by CRY SCON). Type numbers are taken modulo 100, that is
6, 106, 206 etc. all indicate carbon. By default number 99 is deuterium (symbol D) and 98 is
tritium (symbol T).

There arefive optionsfor wavelength; averaged K (alpha); separate K (alpha)landK (alpha)2;
averaged K (alpha) and (separate) K (beta); asingle Specified X-ray wavelength; and Neutron -
wavelength. For thefirst three options, the X-ray tube target element must be selected in the
Radiation combo box. When two wavelengths are cal cul ated, the barsindicating the second
(K(alpha)2 or K (beta)) are shown in red on the screen and in color output, and asadotted linein
black-and-whiteoutput.

In the case of K (alpha) and K (beta) therelative intensity of K (beta) must be specified. For
unfiltered radiation thisisin the neighborhood of 0.2. Of courseit will be smaller for filtered
radiation.
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Thisoption givesonly asemi-quantitative cal cul ation of powder intensity, intended for purposes
of identification. For somewhat more el aborate options, including the ability to show multiple
species, try the program Powder Cell. For highly quantitative reproduction of powder patterns,
there are now many Rietveld programsavailable (see Import and Export files).

Theresults of the Graph option are shown in agraphics windows (see Types of Windows), and
when thiswindow isactive, thefile menu allowsgraphics Print and saving Metafiles. Thereisa
different window for the Old structure and the New structure.

For this option to work properly the space-group symbol entered either in the

Space Group from Table or Custom Symmetry option must be valid for astandard setting. If itis
not, it should be possible to transform to avalid setting. For example, the space group C-1is
sometimes used. Itispossiblefirstly to transform to the primitive cell (use the standard matrix C-
>P). However, thiswould changetheindices of the X-ray reflections. Alternatively, the
transformation could be from C-1 to P-1 with the same cell. The h+k odd reflectionswill have
zero intensity, but the other reflectionswill beindexed asfor the original cell.

If the Index graph box is checked, theindiceswill bewritten above each line. Theindicesare
displaced somewhat in avertical direction if they are close together, but to index complex spectra
it may be necessary to expand the scal e using the 2-theta minimum and maximum settings. The
font for theindicesis 0.8 timesaslarge asthe font for thelegends. Thisfontissetinthe
Window Menu, or the Diffraction Menu of the Control Window.

The 2-theta, d-spacing and intensity (on ascale of 0 to 100 for the strongest peak) for the point of
the cursor are written at the bottom of the window.

2.2.7.2 Precession Pattern

Dialog Box: Precession Pattern [ Diffraction Menu |

Y ou can select either the original (Old) or transformed (New) atoms.

The Precession angle (mu) and Crystal-Film distance should match those of thereal filmto
which comparison isto be made. The Precession angle determinesthe extent of the patternin
reciprocal space. If the Fixed Scale option (rather than Fit in Window) is selected, the pattern
will beintruescale. Thiscan be altered with the Factor, which is 1.0 by default.

The part of thereciprocal lattice shown is determined by the Horizontal axis, the Other axis and
the Level. For example, for aOkl pattern with b* horizontal, the Horizontal axis is b*, the Other
axisisc*, andthe Levd isO.

Reflections are shown as squares whose area.is proportional to the calculated relative intensity.
Theintensitiesare normalized based on the number of electronsin the unit cell (intensity of
reflection 000) and the smallest reciprocal lattice spacing inthisnet. The Intensity factor scales
the edge length, not area, of the squares (thusit really appliesto the structure factor).

If an atom has no temperature factor, the B(iso) value in the Default temper atur efactor edit box
will beused. Extinction and absorption are not considered.
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Scattering factors used by default are those for neutral atoms from Volume 4 of the International
Tables (1974) edition. Atom type numbers must be atomic numbers, or must correlate with the
order of theentriesin the SCATFAC.DAT file. Thisfilemay be edited to supply different
scattering factors (see Files Used by CRY SCON). Type numbers are taken modulo 100, that is
6, 106, 206 etc. all indicate carbon. By default number 99 is deuterium (symbol D) and 98 is
tritium (symbol T).

If the Show grid box is checked, the reciprocal lattice will be shown asagrid in red on the screen
and color output, or as dotted linesin black-and-white output.

Theresults of this option are shown in agraphics windows (see Types of Windows), and when
thiswindow isactive, thefile menu allows graphics Print and saving Metafiles. Thereisa
different window for the Old structure and the New structure.

For this option to work properly the space-group symbol entered either in the

Space Group from Table or Custom Symmetry option must be valid for astandard setting. If itis
not, it should be possible to transform to avalid setting. For example, the space group C-1is
sometimes used. Itispossiblefirstly to transform to the primitive cell (use the standard matrix C-
>P). However, thiswould changethe aand b reciprocal axes and the indices of the X-ray
reflections. Alternatively, the transformation could be from C-1 to P-1 with no changein unit cell.
The h+k odd reflectionswould be cal culated and have zero intensity, but the other reflectionswill
beindexed asfor theoriginal cell.

If the Show extinctions box is checked, systematically absent reflections are marked with asmall
circle, inredin color display and output.

Clicking on areflection will bring up an alert box showing the indices, the d-spacing, the structure
factor (|F|), theintensity (1) and the L orentz-polarization factor.

Thefont for legendsis set in the Window Menu, or the Diffraction Menu of the Control Window.

2.2.8 Window Menu

The Window menu lists all the possible windowsin CRY SCON - those which do not
actually exist are greyed out. Select awindow to make it active, or bring it to the front.

When a Text window or either the Powder or Precession graphicswindow is active, the
first item in the menu isa Font selector. In the Text window, this acts on the entire text
in the window and the font appliesto all Text windows. The font for the powder and
precession windows applies to both windows and to all text, except that the index
lettering in the Powder window is 0.8 times the size of the lettering for legends.
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2.2.9 Help Menu
The Help menu offers the following commands, which provide you assistance with this
application:

CRYSCON Help Topics. Thisbrings up the Help system. Use the Content, Index or
Find tabs to locate information on a particul ar topic.

About. Thisgivesthe version number of CRY SCON. For Macintosh, the About dialog
iseither in the Apple menu (OS 8/9) or the Application menu (OS X).

2.2.10 Transformation Parameters

Dialog Box: Transformation Parameters [ Control Window ]

The structurewhichisinput and listed in the Control Window is referred to asthe Old or original
structure, and that derived from it is referred to as the New or transformed structure.

There arethree optionsfor the symmetry of the transformed crystal; your can use 1) no symmetry,
that is space group P1; 2) you can specify the symmetry; or 3) you can use the program
FINDSYM, by Harold T. Stokes and Dorian M. Hatch, to find the space group. [FINDSY M is
not availablefor Macintosh]

If you want to specify the symmetry (option 2), click on the Transformed Cell Symmetry button if
the symmetry of the New crystal isto be different from the Old symmetry. The default symmetry
isthe same asthe Old. The symmetry specified here pertainsto the New orientation, not the Old,
i.e., CRY SCON does not transform symmetry, so you must supply the correct symbol or
operationsfor the transformed unit cell. The symbolsfor different orientationsarelisted in the
International Tables Vol. 1(1952) Table 6.2, and inthefile HALL.DAT - these symbols all
appear in thelist box in the Space Group Symmetry dial og.

The use FINDSY M option actually usesthe program FINDSY M.EXE (Windows; or findsym
[Linux]) exactly as provided by its authors - this program must be in the CRY SCON home
directory [for Linux, thefilesdata_space.bin and _wyckoff.bin must also be present]. FINDSY M
writesits output to thefile FINDSY M.LOG, and this output is copied line by lineto the
transformation resultsfile output by CRY SCON. FINDSY M usesitsown Tolerance, whichis
similar to that used by CRY SCON (bel ow) in determining whether atomslie on special positions.

FINDSYM alwayslooksfor lattice translations within the generated atoms and assigns new unit-
cell parametersfor the smallest conventional cell. Thusif your matrix specifiesadoubling of the
a-axis, for example, this option will not work - thefinal cell will just bethe original one, with the
a-axisatitsoriginal length. In such acaseif you want to use the symmetry of the supercell you
must determinewhat it isyourself and enter it with option 2). Otherwise, select option 1) no
symmetry. Typically there are substitutions or other deviationsfrom the original cell if you are
going to use asupercell, so after making these modifications you can run the structure through
CRY SCON again with aunit matrix and FINDSY M should find the symmetry, if any.
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FINDSY M uses certain conventions and there are limitations to the output - the resultswill use
thefollowing settings.

monoclinic: uniqueaxisb, cell choicel
rhombohedral: hexagonal axes
originchoicel

Thusthis option cannot be used to transform into arhombohedral cell, for example. However, the
symmetry of thetransformed structure can be determined, then the Transfor med tol nput option
in the Input menu can be used, then the structure can be transformed again to the desired setting of
the space group using that specified symmetry.

The Number safter decimal isapplied to the fractional atomic coordinates. Atomic positions
from X-ray diffraction typically are good to 5 or fewer decimal places, but some programs may
require the positions of atomswhich arein special positions containing coordinates of 1/3, 2/3 etc.
to be specified more precisely. Thisshould occur only in rhombohedral crystals using hexagonal
axes (and even then atomsin the unit cell can be selected which do not contain the rhombohedral
lattice tranglations), or in some hexagonal crystals.

Three types of transformation can be carried out.

1. Trandation only simply addsthe Pre-symmetrytrandations to the input atoms (Old or
original atoms) and does nothing else.

2. Input atomsonly applies pre- and post-matrix translations and the translation matrix, but does
not try to fill out the unit cell for either the old or new setting. The number of New symmetry-
unique atoms will be the same asthat of the Old input atoms. Thisisthe only option which will
transform anisotropic temperature factors. Thisoption may be used for simple reorientation
involving interchange of axes, and other transformationswhich do not involve achange of
symmetry or primitive unit-cell volume. It can be used for primitiveto non-primitive
transformations and vice-versa, and transformations among different non-primitive Bravaiscells.
Again, the correct symmetry for the New orientation must be supplied. Usethisoption when
transforming from Cartesian coordinates, asin an imported PDB or mmCIF file, to crystal
coordinates

3. Full unit cells will transform all atomsin the Old unit cell to those in the New unit cell,
generating new atomswhen necessary (supercell or decrease of symmetry) and averaging atomic
position when that isnecessary (subcell or increase of symmetry). Anisotropic temperature
factorsare not transformed - they are converted to isotropic. Vectorsaretransformed, although if
the symmetry is changed the new vectors are not guaranteed to be consistent with the new

Ssymmetry.

The Tolerance isused to decideif atomsare coincident, and their positions should be averaged (if
the unit cell isdecreased in volume, or the symmetry isincreased). Thetolerancein Angstromsis
converted to fractional coordinateson x, y and z, and applied to each atomic coordinate in turn.
That is, atoms are considered to be coincident if they fall within aunit-cell shaped box with edges
of length equal to thetolerance.
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The Number safter decimal box specifiesthe number of figures after the decimal for fractional
atomic coordinates. Thisalso appliesto CIF file export.

Usesymmetry on vectors. If thisbox is checked, vectors (such as magnetic spin vectors) will be
operated on by the symmetry elements. If not, the atoms generated from each input atom will all
have the same vector as that input atom. Note that CRY SCON, unlike ATOMS, does not apply
Shubnikov symmetry.

The Standar d matrices combo box will supply matricesfor some common unit-cell
transformations. These matrices should all preservethe chirality or "hand" of the structure - other
combinations of signs on the coefficients are possible, particularly for the last five matricesfor
simpleinterchange of axes.

The parameters specified on the | eft side of the Tranfor mation Par ameter sdialog, going
downward in the dial og, correspond to the operations successively carried out by CRY SCON -
see General Procedure for more detail. After setting and verifying all parameters, click onthe
Transform button, and the results appear in anew text window (see Types of Windows).

First, Pre-symmetrytrandations may be applied to the input atom coordinates. If the origin for
your atomic coordinates does not correspond to that of the standard symmetry specified for the
Old crystal, corrections must be made here.

If you havethe inverse transformation matrix or that for going in the opposite direction to that
desired - that is, you have the "new" to "old" matrix - you can enter the matrix and then use the
Invert Matrix button.

---Transglation only (origin shift) option

Nothingbeyond Pre-symmetrytrandations is done—the remainder of the parametersare
ignored.

---Input atomsonly option.

The Pre-matrixtrandations are applied to the Old input atoms, they are transformed with the
matrix, and the Post-matrixtrandations are applied. (Pre-symmetrytrandations are not used).

Usethisoption if you want to convert aset of atomsin Cartesian coordinates to fractional crystal
coordinates, asfor aPDB file.

---Full unit cellsoption

CRY SCON now generates all the atomsin the Old unit cell. If the origin of the New unit cell
differsfrom that of the Old, with respect to the common symmetry elements, you must make
correctionsin either thePre-matrixtrandations or Post-matrixtrandations edit boxes. Such
differences among sub/supergroups are common, and it may be necessary to study the diagrams
and coordinatesin the International Tables to get these translations. CRY SCON transformsthe
vectorson theinput atoms with the symmetry matrices. Inthe case of special positions, the vector
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istaken from thefirst atom generated for that position. For subsequent atoms generated for that
position, the new vector iscompared and awarning messageissued if the two vectors are not the
same.

The transformation matrix isin the nine edit boxes. Some common standard transformation
matrices may be selected in the Standar d matrices combo box to the right. The upper three
coefficients (first line) of the matrix give the New a-axisin terms of the old a, b and c axes.
Likewisethe second and third lines specify the new b- and c-axes.

CRY SCON now transforms the coordinates according to the matrix supplied, adding additional
atoms by translation if necessary, or averaging atomic positionswhen necessary. The Tolerance
is used to decide when atomic positionsare "coincident”, and must be averaged. Thetolerance
should be large enough to avoid having quasi-superimposed atomsin the result, but of courseit
must be less than the smallest bond length in the structure. Setting this may take sometrial and
error. A value of 0.4-0.5 seemsto belarge enough for even rather extreme cases of atomic shifts
in sub/supercells and sub/supergroups.

CRY SCON does not attempt to average vectors on coincident atoms; it takes the vector from the
first-generated atom and i ssues awarning message if vectors on subsequent coincident atomsare
not the same.

Post-matrixtrangations may be applied hereif the standard origin for the New space group is
different from that of the Old space group. Thisisan alternative to the Pre-matrixtrandations -
it should not be necessary to use both.

CRY SCON now appliesthe New symmetry to eliminate symmetry-equivalent atoms. Againa
toleranceis applied to decideif atom positionsare "coincident”. Thisgenerates astandard set of
symmetry-unigue atoms, or the"asymmetric unit”. However, in many caseswhen generating a
subcell or increasing the symmetry the averaging process does not put the new atoms exactly on
special symmetry positions and the cal culation must be repeated in part - see General Procedure.

The Clear button resets the transformation matrix to the identity matrix, and it also resetsthe
Symmetry to be the same as that of the Old structure.

The Transform HKL file buttonwill read afile containing index data and transform the indices.

2.2.10.1 Transform Face or Reflection Indices

Transform Faceor Reflection IndicesFile[ Transformation Parameters dialog |

Thisoption will read afile containing alist of X-ray (or other diffraction) reflections, or just alist
of crystal faces, and transform the hkl indicesto anew axial system or unit cell.

Y ouwill be asked to specify theinput file, and the output file (which must be different).

The data to be transformed must bein atext or ASCI| file with one hkl per line. The datamust be
in fields separated by spaces.

Specify the numbersof thethreefields or columns containing the hkl indices (integers). Other
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fields or columnswill simply be copied to the output file (these are read as strings). Therewill be
one space between thefieldsin the output file - column formatting will not be preserved.

Lines not containing three valid numbersin the columns specified for hkl index datawill simply be
copied to the output file. In many casesthiswill give an output filewhich isidentical to theinput
file except for the transformed indices. If thereisany doubt about whether other types of datain
thefile may contain three numbersin thesefields, the valid output with the transformed indices
can be cut and pasted back into the original file.

To reach thisoption, click on the Transform button in the Control Window. The only datawhich
isused in the Transformation Parameters dialog is the tranformation matrix. It isnot necessary to
click the Transform button to transform indices.

Itispossibleto haveinvalid transformed indices. For example, if the a-axisishalved, the indices
(200) will be tranformed to (1/2,0,0). CRY SCON will attempt to clear such fractional indices,
for example changing (1/2,0,0) to (1,0,0) and (1/2,1,0) to (1,2,0). Note that such changed indices
will bevalid for morphology, but not necessarily for diffraction. If one of the extrafieldsin the
file (notindices) isthe d-spacing (or central distance derived therefrom) it will not be changed and
thus some values may not correspond to the new indicesif fractions are cleared.

2.3 Text Windows

When atext window is active, the menu bar contains aFile Menu, for saving and printing the
contents, and astandard Edit Menu for editing the contents.

To return to the main menu bar, click on the Control Window (see Types of Windows), or use the
Window menu.

The Transform button in the Tranformation Parameters dialog lists the transformed atom
parameters and other data to a separate Text window. TheListing optioninthe

Powder Diffraction dialog (File Menu) lists the data to a Text window, as does the

Bond Lengths and Angles dialog (called from the Control Window). Each window actually
displaysthe contents of afile, called respectively LIST.DAT and BONDS.DAT. Thesefilesare
written over again each timethe respective optioniscalled, so if they areto be preserved they
should be saved with the Save As commandinthe File Menu, using adifferent name.

2.4 Powder Diffractogram Window

Thisisagraphics window which appears as the result of the Powder Diffraction dialog (Graph
option) inthe Diffraction Menu. It may show either the old or original atoms, or the new or
transormed atoms.

To return to the the Control Window if it is not visible, use the Window Menu.

File Menu. In addition to the standard Save, this has options for printing and graphicsfile output.
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Window Menu. To set thefont (for all diffractogram windows) and switch between windows.
2.4.1 File Menu (Diffraction Graphics)

The options here for graphics output (Print, PostScript, Raster, Metéfile or PICT) are for
Powder or Precession graphicsonly.

2.4.1.1 Print Graphics

Dialog Box: Print GraphicsImage [ File Menu (Powder) or FileMenu (Precession) |

PostScript printing is standard in Linux, so graphics printing is handled by the
Direct PostScript option, not by the dialog below.

If the Standard printer dialogon OK box ischecked, the Print dialog supplied by the operating
system or the printer driver comes up after you click OK. Usethat dialog to set the number of
copies, the orientation (Portrait/L andscape) or the resol ution.

Color output gives essentially the sameimage as on the screen, with the barsfor asecond
wavelengthinthe Powder pattern, and the reciprocal-lattice grid in the Precession pattern being in
red. If the Color box isunchecked, these lines are shown dotted. If you have acolor printer, you
may need to make achoice between color and black-and-white printing in one of the printer
dialogs aswell aswith the Color printing checkbox inthisdialog. Thischoice may be an option
in the standard printer dialog above, or you may need to set it in the Print Setup optionintheFile
menul.

See Frames for details of the frame and frame units.

2.4.1.2 Page Settings

This allows setting of the paper type or size, the standard orientation (portrait or
landscape) and the paper margins. Marginswill only beused in Text Windows.

For Macintosh, margins are set in Page Margins.
2.4.1.3 Page Margins

----- Macintosh only----

This dialog sets the margins for Text Windows. Use the Page Setup dialog to choose page
size and orientation.
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2.4.1.4 PostScript Output
Dialog Box: Direct Postscript Output [ Eile menu]

PostScript printing is standard in Linux, so for non-3D output, including diffraction
diagrams, printing is routed to this dialog, not the Print Graphics command in the
File menu. Output can be directly to the printer or to an EPSfile, as for Windows
(below).

---- Windowsand Linux only ----

This option can be used to write Encapsul ated Postscript (EPS) files for transmission of
graphicsto other software, as well as for direct output to a Postscript printer. This direct
output is generally superior to, aswell as faster than, the output from the normal

Print Graphics command in the File menu if your printer is PostScript. The Destination
option sends output either directly to aprinter or to afilein standard EPS (Encapsul ated
Postscript V3.0) format.

Screen Preview.

Most word-processing and publishing software cannot display an EPSfile on the screen
unlessthefile hasaspecial bitmap attached, called the screen preview. Thisisactually a
sub-filein the TIFF format. The pixel depth of thisfile can be set in the

PostScript Settings dialog (Settings button). The pixel depth of the preview is set to that
of the screen, and the pattern seriesis set to fine (see Raster Files).

---- Macintosh only ----

This option can only be used to write Encapsul ated Postscript (EPS) files for transmission
of graphics to other software. For direct output to a Postscript printer, use the Print
option.

Screen Preview .

Most word-processing and publishing software cannot display an EPSfile on the screen
unlessthefile hasaspecial attachment, called the screen preview. Thisisactualy aPICT
in the resource fork of thefile.

---- End Linux/Windows/Macintosh only ----

Settings button (PostScript Settings dialog). On or before first using the Dir ect
PostScript Output command, you should set or verify the settingsin thisdiaog,
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especially the port to which the printer is attached.

Fonts in PostScript output . Depending on your system configuration (Windows or
Macintosh, printer type and driver), the PostScript fonts supported by a PostScript
printer may or may not appear in the dialog for selecting fonts which may be called from
the xxxx dialogs. Furthermore, you may want to write EPSfiles for a printer which is not
even connected to your computer. These dialogs thus have an option to specify a
character string for the PostScript font. This string specifies the typeface, and includes the
weight (normal, bold) and other attributes (italic or oblique), but does not include the size
- the sizeis specified in the font dialog. There are certain standard PostScript typefaces
which are present on most PostScript printers.

See Frames for details of the frame and frame units.

2.4.1.5 PostScript Settings
Dialog Box: PostScript Settings [ Direct Postscript Output Dialog]

The page size, page margins and dots per inch/centimeter should be determined by the
actual printer used for final output; if these are not correct, the drawing may not be scaled
and/or placed on the page correctly.

Preview Color. If you select a screen preview (TIFF bitmap or PICT sub-file) in the
Direct PostScript Output dialog, and if color output is selected, you can specify either a
color or black-and-white bitmap. The Screen option uses the color depth of the the
current screen display. Black-and-white PostScript output always uses a 1-bit or black-
and-white screen preview.

---- Windows only ----

If you are using direct output to a printer you must select the Port; thiswill be either
"LPTn" or "COMN". Also, if you are using aseria port for the printer, you must set or
verify the data transmission parameters, such as baud, parity, etc., even if the port
currently shown isthe correct one. Thisisdonein the Ports item of the Windows
Control Panel (not in CRY SCON).

2.4.1.6 Raster Files
Dialog Box: Raster (Bitmap) Files [Filemenu]
--WindowsOnly ----------

Thiscommand can writefilesin four different formats (File type): Windows device-
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independent format (.BMP); PC-Paintbrush (.PCX); Tag-image-format (.TIF); and
Portable Network Graphics (.PNG) files.

--Macintoshonly---------

This command can write filesin the Portable Network Graphics (.PNG) format. The
PICT/Clipboard option (File menu) can also write raster or bitmap files, in the PICT
format.

--EndWindows/Macintoshonly----
See Selection of File Format below for information on choosing the format.

The drawing may be either black and white or color. If black and white, the pixel sizeis
1-bit. For color filesthe pixel size may in some cases be selected. In Windows, 16-bit is
only availablefor .ompfiles. In Macintosh, 8-bit (256-color) isonly availableif the
screen is currently set at this color depth.

If the Compress box ischecked, .TIF files are compressed with run-length encoding,
which is one of the required formats under the TIFF 6.0 standard. However, some
applications may not support thistype of compression, or may reject . TIF filesfor other
reasons. Also, if the Compress box is checked, 4- and 8-bit .BMP files are compressed.
1-bit and 24- bit .BMP files are never compressed. Owing to a Windows system bug,
compression of 4-bit .BMP files may not work when banding is used (see below). .PCX
filesare always compressed. with their own format. 24-bit .PCX files can compresswell,
whereas 24-bit .TIF filesare only partially compressed (and then only if there are large
areas of black, white or grey), and 24-bit .BMP files are not compressed at all. PNG
filesalso are always compressed.

See Frames for details of the frame and frame units.

Maximum memory. Windows and Macintosh both use virtual memory , which means
that they pretend that a hard disk can be used in place of actual hardware memory chips.
For some applicationsthisisuseful, but when writing raster filesit usually resultsaform
of lingering death involving "disk thrashing"”, or constant reading and writing of datato
the hard disk.

CRY SCON is capable of imaging and writing raster filesin segments or bandsto avoid
this problem. Thisrequires repeating the entire drawing process for each band, but this
usually ismuch faster than the reading/writing to disk involved in using virtual memory.
To do thisrequires knowing how much actual chip memory isavailable. Unfortunately,
at present Windows does not provide this information in away that can be used for both
16- (standard Windows 3.1) and 32-bit (Windows 95/98/NT/XP) systems. Thusthe user
may need to determine this by trial and error using the Maximum memory parameter.
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When the M aximum memory parameter is set to zero, CRY SCON will ssimply ask the
system for ablock of memory large enough to image the entire drawing at once. This
amount of memory is printed out in the dialog which appears after starting the raster
imaging: "nnnn bytes required, mmmm bytes available - will require 1 bands". If this
amount of memory is greater than the amount of chip memory available, Windows will
usevirtual memory, whichistypically manifested by constant running of the hard disk for
long periods (disk thrashing). If you change the M aximum memory to some amount
smaller than nnnn (say half), CRY SCON will only request thisamount of memory from
the system, and virtual memory may not comeinto play. A Maximum memory setting
should be good for agiven session, regardless of the size of theraster file; larger fileswill
use more bands. However, the amount of memory available may depend on whether
other applications are active.

The amount of virtual memory is determined by the available space on the hard disk. If
thisisinsufficient, CRY SCON will automatically use bands, but sincevirtual memory is
being used, it may still be advantageous to use a M aximum memory valuewhich will
increase the number of bands.

Selection of File Format. The choice of format dependsfirst of all on what formats are
supported by the target software (paint program; publishing program; etc.). Beyond this
the first choice should be PNG, second choice PCX, and then PICT, TIF or BMP
depending of what is supported and how much memory or disk spaceisavailable.

Asof 1997, the preferred graphicsfile types for the internet were GIF and JPEG.
However, GIF usesthe LZW compression scheme copyrighted by Unisys Corp., whichin
principle chargesalicensefeefor every application using it. JPEG files are compact but
involve losses and degradation of the image and are thus not suitable for CRY SCON
files.

The PNG format isintended to be areplacement for GIF, and in fact is superior to most
other formats, being lossless and giving very good compression for the type of images
generated by CRY SCON. Essentially all mgjor software vendors have subscribed to the
PNG convention and releases from 1998 onward should support it.

Most TIF filesalso use LZW compression, but CRY SCON does not use this type of
compression because of the copyright problem. The run-length-encoding which

CRY SCON does use is supposed to be supported by all TIF readers, but in fact some do
not support it, and this algorithm does not work well for 24-bit (RGB) images.

PICT bitmap files on the Macintosh are compressed by the system software and the
algorithmmay vary. PNG filesareusually smaller.

There are dozens of raster graphicsformats and it will never be possible for CRY SCON
to support al of them. CRY SCON users who work with raster files should consider
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investing in aconversion program - there are many such programs which are not
expensive. The PNG home page (www.cdrom.com/pub/pnp) has links to many
shareware and conventional commercial conversion packages.

2.4.1.7 Metafiles
Dialog Box: Metafiles [ File Menu ]

---- Windows Only ----------

Windows metafiles are basically vector images (but including fills) that can berescaled
without necessarily losing resolution. They record the drawing commands that are used
for the screen or standard printer output, but the result may depend on the software or
devicefor which they areintended. A metafileimage may either be saved in the
Clipboard, to be Pasted into another application, or written to afile.

CRY SCON can write three types of metafiles. Theoriginal or Standar d metafile format
has proven inadequate for transmitting scaling information, and many applications do not
even accept Standard metafiles. Placeable metafiles, aformat which was originated by
Aldus Corporation, contain scaling information in an additional header. The standard and
placeable metafiles have the WMF extension. WMF or standard files are 16-bit format,
i.e. use 2-byte integers. Enhanced metafilesare 32-bit format fileswhich also contain
scaling information. They arethe preferred type of metafile for use in 32-bit Windows
systems (Windows NT or Windows 95), but cannot be used in standard 16-bit Windows
3.1or Win32s.

Original (16-bit or WMF) metafiles can be written with either of two Scaling M odes;
Isotropic or Anisotropic. Isotropic supposedly keeps the same proportions. Generally,
Isotropic isthe best asit allows rescaling while preserving proportions. However, some
applicationsonly accept Anisotropic files, and some ignore the scaling mode completely.

When writing to afile, to prevent loss of resolution, CRY SCON uses a standard scaling
of 2540 dots or pixels per inch (1000/cm). However, some drawing applications may
not read the scaling correctly (assuming 72 dpi) and it may be necessary to rescale the
drawing after importation.

When writing to the clipboard, CRY SCON uses the current screen resolution, which
usually isabout 92 dpi. Thisisbecause most drawing applications assume screen
resolution or 72 dpi. The clipboard image can be either 16-bit (.wmf) or 32-bit (.emf)
according to the setting of the Type option.

See Frames for details of the frame and frame units.

Limitations of Metafiles. Asdesigned and implemented by Microsoft, the metafile allows
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recording of al Windows drawing commands, so that afile image can be acopy of what
is shown on the screen but rescalable. Unfortunately non-Microsoft drawing applications
(e.g. Corel Draw, Adobe Illustrator) sometimesimplement metafilesincompletely or
incorrectly so that there are some limitations in metafiles written by this option, in order
to allow them to work in as many applications as possible. It many be necessary to try
many combinations of settings (Destination, Scaling mode, Type of file) to get
satisfactory resultsin an importing program.

1) Resolution for the clipboard is now that of the screen, typically 72-96 dots-per-inch
(dpi) - earlier versions of ATOMS used 2540 dpi. The lower resolution should not cause
problems except for very complex drawings - if a drawing looks good on the screen, it
should look good in adocument. If the clipboard is unsatisfactory use afile.

2) Bitmap patternsfor black-and-white images cannot be used. Fillsare transmitted as
gray shadeswhich are interpreted by the importing application and/or printer.

3) A background is always present, to insure correct scaling. With some care, this
drawing element may be removed inimporting applications.

4) Thereisno clipping of theimage, although some importing applications may use the
drawing framefor clipping.

5) Transmission of theimagein Corel Draw with the Clipboard may require use of
Edit/Paste Special rather than asimple Paste.

6) Adobe Illustrator generally does not do well with labels - is may be necessary to use
an EPSfilefor Adobe Illustrator. Label backgrounds may not be transmitted in other
applications.

If ametafileis not satisfactory, araster file can be used. PNG raster files are often
smaller than metafiles, especially for complex drawings. Also, many drawing programs
now support import of EPS (Direct PostScript) files. EPSisusually the preferred type of
filefor Adobe Illustrator.

2.4.1.8 PICT/Clipboard
Dialog Box: Clipboard/PICT [ Eile menu]

Note that this type of output may be referred to elsewhere as Metafile output. This
option can write images either to the Clipboard or to PICT files, in either of two formats:
(a) arescalable 2-dimensional Picture or metafile, or (b) araster image or bitmap.
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Macintosh Pictures, as used here, are images containing lines or vectors and fills of
regions defined by lines, that can be rescaled without necessarily losing resolution. They
record the drawing commands that are used for the screen or standard printer output, but
the result may depend on the software or device in which they are used.

Bitmaps or raster images record every pixel, so they are not susceptible to undesirable
modification by other software. Although most "painting” software can resize bitmaps,
thisusually causesaloss of quality, soitisbest to save abitmap in exactly the desired
size. Note that you can also save bitmapsin the PNG raster format (File menu), whichis
superior is some respectsto PICT files.

If color output is selected, you can choose either 16- or 32-bit color depth - 8-bit (256-
color) files cannot be written.

Y ou can select the nominal dots per inch/centimeter, but note that programs which read
the file may ignore this and show theimage at 72 dots per inch.

See Frames for details of the frame and frame units.

2.5 Precession Pattern Window

Thisis agraphics window which appears as the result of the Precession Peattern dialog (Graph
option) inthe Diffraction Menu. It may show either the old/original atoms, or the new/transormed
atoms.

Toreturn to the the Control Window if it is not visible, use the Window Menu.

File Menu. In addition to the standard Save, this has options for printing and graphicsfile output.

Window Menu. To set thefont (for all diffractogram windows) and switch between windows.

3 Reference
Topicsof general interest.

Atom Parameter Files (Free-Form)

ATOMS and VIBRATZ files

Files used by CRY SCON

Frames
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Samples

Standard PostScript Type Faces

3.1 Atom Parameter Files (Free-Form or .inp)

Thistype of ASCII or text file may be used to read in atomic coordinates alone, or to supply
complete structure information. Listings of atomic coordinatesfrom almost any source can be
used asthe basis of afree-formfile.

CRY SCON will also export this type of file, which can beread into ATOMS, SHAPE or
VIBRATZ (Shape Software).

All or part of the parametersfor each input atom, namely label, fractional coordinates, type,
radius and display colors and pattern numbers, can beread in. Y ou can also supply default values
for some parameters, so that the parameters neither need to be present on every line of thefile, nor
need to supplied through thedialog.

Except for the TITL line, keywords and actual valuesto be read in should be separated by spaces
or commas, and there should be no spaceswithin keywords or values. Thereisno need for
alignment by column, except that keywords should start in thefirst column.

Theinput file may contain two overall types of lines; General and crystallographic information
lines; and actual data or atomic parameter lines .

General and crystallographic information lines. Theselines should all precede the atomic
parameter lines. Each line consists of akeyword followed by one or more values or character
constants. The keyword should start in thefirst column and be followed by at |east one space
before the actual values. Where more than onevalueiscalled for, they are separated by spaces.
All of theselines are optional - when afree-form fileisused for import (File menu), if any lines
are absent, default valueswill be supplied.

TITL line. Upto 76 characters (may contain spaces).

CELL line. Theunit-cell lengthsin Angstromsand theinteraxia anglesin degrees (6 floating-
point values). If the atomic coordinates are Cartesian, the axes should be 1.0 and the angles 90.0.

SPGP line. The Hermann-Maughin or standard International symbol for the space group. There
should be no spacesin the symbol, although there may be underscores (which areignored when
thesymbol isinterpreted.

HALL line. TheHall symbol for the space group. There should be no spacesin the symbol,
although there may be underscores (which areignored when the symbol isinterpreted. If thisline
comes after the SPGP line (or that lineis absent), the Hall symbol will be used in the

Space Group Symmetry option.
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SYMM lines. These give symmetry operatorsin"xyz" form, that isin the form in which the
coordinates of the general position arelisted inthe International Tables for X-Ray
Crystallography. Fractions must be given as integers separated by adlash ("1/2", "2/3"), rather
than decimals ("0.5", "0.333"). Thex, y and z positions must be separated by commas and there
should be no spacesin the operator. There should be oneline for each operator. If the space
group is centrosymmetric, only half the operators need be given, if the originison acenter of
inversion. If theoriginisnot on acenter, all operators must be given and the space group should
bedenoted non-centricinthe LATT line. If these lines come after the SPGP and HALL lines (if
the latter are present), the Custom Symmetry option will be used.

LATT line. Thisgivesthe Bravaislatticetype (single capital character), followed by a space
and O if the space group is centrosymmetric or 1 if it isnon-centric.

FACTOR line. A single(floating-point) factor which multipliesall thefractional or atomic
coordinates.
Atomic parameter lines :

Thefile should have all theinformation for each atom, except for temperature factors, on asingle
line with a maximum of 80 characters per line, and the values must bein fields , which are set off
or delineated with either spaces or commas. There can be no spaces or commaswithin fields. The
names of fieldsare given in thefollowing in capitals, but in the actual input they may be lower
case; all letters are converted to upper case when thelineisread in.

DEFAULT lines supply valuesto the parameters, such as colors, which are not read in for each
atom. If default values are not entered in thisway, default values are obtained from the separate
ELEMENTSfile, using the chemical symbol of the atom which isassumed to bein thefirst two
characters of the atom label. Seethe further description of DEFAULT linesand the
ELEMENTSfile below.

FIELDS lines. Theselines set up the CRY SCON input parameters which are to be read from
thefile, and the order in which they areto beread. . Thisisfollowed by the keywords giving the
order of thefields. The allowed keywords are asfollows (INTEGER fields may not contain a
decimal point):

1) LAB - (6 characters maximum). Any label for the input atom may be used, but the |abel
normally beginswith the chemical symbol for the element. Thefirst two characters may be used to
determine default values for some of the parameters, as described below. The characters may be
upper or lower case. Thisisarequired field.

2) COO - Thisactually denotesthreefloating-point fields giving the fractional atomic
coordinates. After input, the coordinates are multiplied by the number inthe FACTOR line, if
thislineispresent. Thesearerequired fields.

3) TYP - Thisisthetypewhichisused in locating bonds and polyhedra. INTEGER
Fields4-9 arefor usein ATOM S and are not used by CRY SCON, but if the datawas originally

imported from ATOMS (.STR), they will bewritten in an Export filefor re-introduction into
ATOMS.
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4) RAD - Thisisthe radius used when the atom is plotted as a sphere. FLOATING-POINT
5) RMC - Thisisthe color number for the atom rim or edge. INTEGER
6) FLC - Thisisthe color number for the atom fill. INTEGER

7) RMP - Thisisthe pattern number or gray shade used in black-and-white display or output.
INTEGER

8) FLP - Thisisthe b/w pattern number for fills. INTEGER

9) PEN - Thisisthe pen number used for atom outlinesin pen plots. INTEGER

Thefollowing fields may be used by CRY SCON.

10) TFB - Temperature factorsin B or bij (beta) form, types O (anisotropic) or 6 (isotropic) in
ORTEP. If thiskeyword is present, the temperature factor(s) are present on asecond linefor each
atom, inup to six fields Theorder is11, 22, 33, 12, 13, 23. If the second value is absent or zero,
the temperature factor will beread asisotropic. Notethat CRY SCON will save temperature

factorsonly if at least one atom has non-zero for thefirst value or b11.

11) TFU - Temperature factorsin U or uij form, for anisotropic type 8 in ORTEP. Similar to
TFB. Isotropic U vaueswill be given number 10, although thisis not standard ORTEP.

12) VEC - Atomic vectors, e.g. for magnetic spinsor vibrational displacements. If thiskeyword
ispresent, the vector coefficients are present on asecond line, in four fields. Thefirst threeare
the relative componentsin the structure axes, and the fourth isthe length. Vectorsand
temperature factors may not both be present.

13) DUM - Thisdesignatesafield (character, integer or floating-point) that existsin theinput
dataline, but should beignored by CRY SCON.

Notethat the actual atom datalines do not contain any keywords. Thekeywordsinthe FIELDS
lines set up the sequence of parametersin each dataline.

AnexampleFIELDSline:
FIELDSDUM LAB COO TYPRAD
Somecorresponding datalines:
1C10.1234 0.23450.3456 6 1.2
2H20.43210.5432 0.654310.1

Herethefirst field, which is simply a sequence number, must beignored by CRY SCON, and is
designated withaDUM.
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Hereisan example of somelines copied from an (old) ATOMS .STR file (spinel):

FIELDS DUM LAB TYP COO RAD

1 MG1 12 .12500 .12500 .12500 .000
2 AL2 13 .50000 .50000 .50000 .000
3 O3 8 .26200 .26200 .26200 .000

There should normally beaFIELDS line at the beginning of the atomic parameter lines, but
additional FIELDS lines can beinserted at any point to redefinethefields. If thereisno FIELDS
line, thefields are by default; LAB and COO.

In the actual datalines, fields denoted INTEGER above should not be more than 6 characters; the
COOQO and RAD fields (floating-point) should not be more than 20 characters.

DEFAULT line. Thisisused to set particular default values for fields other than LAB or COO.
DEFAULT must bethefirst 7 characters. Then the default values are indicated with the name of
the field connected with an equals sign (with no intervening spaces) to an appropriate val ue.
Exampledefaultline:

DEFAULT TYP=1RAD=0.95 FLC=15

There aretwelve possible input fieldsfor each input atom, or each linein thefile, plusthe
placeholder DUM field. The LAB and COO fields are required for each atom and must beread in
from thefile; the other fieldsare optional. If the latest FIELDS line does not defineafield for a
particular parameter, then the value of the missing parameter is determined by reading thefirst
two characters of thelabel (LAB field) and trying to identify the element. Y ou can turn off
defaults, thereby accepting the values on theinput atom line, with aline containing the word
DEFAULT and no other keywords.

3.2 ATOMS and VIBRATZ files

CRY SCON users may want to use or transform the data in the Shape Software programs
ATOMS, for drawing crystal structures, and VIBRATZ, for normal-coordinate calculations. The
datafilesfor both these contain far more data than CRY SCON requires, and while Crycon will
Import either type of datafile, it will not export either type. The procedure for taking datafrom
these programs, using it or transforming it, and returning it to these programsis asfollows.

1) InCRYSCON, directly Import the ATOMS (.STR) or VIBRATZ (.\VBR) files. All data
required by CRY SCON should bein thesefiles. Of course both of these programs handle
molecules or polymersaswell as crystals, and CRY SCON deals only with crystals.

2) If the abjectiveisto simulate Powder or Precession patterns or diffraction listings, no
transformation isrequired - just select the desired option from the Diffraction Menu.
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3) Totransform the data, follow the procedure outlined in General Procedure.

4) Toreturn the transformed datato ATOMS or VIBRATZ, select Export in the File menu, and
write aFree-form (.INP) file.

5) ATOMSor VIBRATZ can now import the .INP file through the Import optionsin their File
menus. Inthecaseof ATOMS, it isalso possibleto read the datainto an existing file (for
exampletheoriginal datafile) through the I nput Atoms dialog (Input menu). Thishasthe
advantagethat all pre-existing specifications, including bondsand polyhedra, are preserved.

When an ATOMSfileisread into CRY SCON, the data on color and atomic radius are preserved,
although they are not used by CRY SCON. They arewritten out in the .INP export file and will
be read back into ATOMS (see Atom Parameter Files).

The program SHAPE will also read .INP files, so can use transformed data from CRY SCON.
Transformed{linkN

3.3 Files Used by CRYSCON
CRY SCON recognizestwo filefoldersor directories; the home directory and the data directory.

The home directory isthe one containing the CRY SCON program file or application. This
directory must also contain the following dataand setup files:

SCRPTR Thisisthe setup or preferencesfilefor CRY SCON. If it isdamaged or lost another
will be created, with default values. Thisfileisreplaced after the first startup with a user-
and platform-specific file.

HALL.DAT Thisisthefile containing space-group data.
CIFDIC.SHT Thisisarequired dictionary file for importing CIF files.

SCATFAC.DAT Thisfile containsthe X-ray scattering factor data for neutral atomsin the
exponential formasgiveninthe International Tables, Vol. 4. Thisfile may be modified to use
other scattering factors (e.g. for ionized atoms). The scattering factors are keyed by sequence
number asread from thisfile to the atom type. Thereisamaximum of 100 scattering factors.
Type numbers are taken modulo 100, that is 6, 106, 206 etc. all indicate carbon. By default
number 99 is deuterium (symbol D) and 98 istritium (symbol T). For neutron diffraction
involving isotopesit isasimple matter to copy thelinefor the element in question into aposition
whichisunlikely to be used, such as numbers 93 to 97, and change the neutron scattering length,
whichisthelast coefficient (thefirst 9 coefficients give the X-ray form factor).

Thefollowing filesare alwayswritten to the home directory.

BONDSL1.CCD, BONDS2.CCD Thesefilescontain the results of the Bond L engthsand
Anglescommand (Control Window).
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POWDER21.CCD, POWDER2.CCD Thesefilescontain thelisting of d-spacings, etc. from the
Powder Diffraction command (File Menu), Listing option.

The BONDSN.CCD and POWDERN.CCD files are rewritten every time you use the Bond
Lengthsand Angles or Powder Diffraction (Listing) commands. Thusto save these results
permanently, use Save As (File Menu) to save them with adifferent name.

The data directory isthe one containing the current datafile. Thisdirectory issavedinthe
SCRPTR or user- and platform-specific file, and thus the Open command returnsto it when you
start up CRY SCON.

infile .CCD Thisisthe output file from the Transform command (button) in the

Transformation Parameters dialog - hereinfile isthe name of the CRY SCON datafile (infile
.CCO). It containsalisting of the atomsin the original unit cell and the transformed unit cell, and
the transformed symmetry-unique (input) atoms. ItisdisplayedinaText window (see

Types of Windows).

infile XXX Export files are given the appropriate default extension (.XXX), and are written by
default in the datadirectory, although you can write them with any extension. Changing the
directory in which thefileiswritten resetsthe data directory.

3.4 Frames

Frames [ Print Graphics, Metefiles ]

With printed output, you have achoice of using thefull page, or confining the output to aframe .
For Metafiles (File menu) output always goesto aframe.

If you are using the Fixed scale mode for a Precession or Powder pattern, theimageis clipped to
theframe. Otherwise, theimageisscaledto fit theframe.

In printed output, the frame can be positioned on the page; the offset givesthe displacement of the
upper left corner of the frame from the upper left corner of the page.

Y ou can choose the unitsfor the size and offset of the window; either inches or centimeters.

3.5 Samples

All theexamplesarereal minerals, and the tranformations are between non-equivalent but similar
structures, not just changes of axes. There are files transforming each structure in the set to the
other structure(s).

Thetransformationstypeis Full unit cells.

Mar casite(mc)-ar senopyrite(as). In addition to the substitution of Asfor one of the sulfursin S2
groups, the cell and symmetry are different.
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Columbite(co)-huebnerite(hb)-wodginite(wo). These oxides have the same basic structure,
differing in the pattern of cation substitution.

Cubicboracite(boc)-orthorhombicboracite(boo). Thisisahigh-low temperature transition.

Thelow-temperature orthorhombic formisferroel ectric and can take several orientationswith
respect to the cubic high-temperature form. Some atomic displacements are quite large.

3.6 Standard PostScript Typefaces
Standard PostScript Typefaces (Font Families)

The names of the fonts should be entered exactly as given, with no embedded spaces. If
your printer does not recognize afont string, it will probably default to Courier.

Times Roman Family

Standard: Times-Roman
Slanted: Times-Italic
Bold: Times-Bold

Bold Slanted: Times-Boldltalic

Helvetica (Swiss) Family

Standard: Helvetica
Slanted: Helvetica-Oblique
Bold: Helvetica-Bold

Bold Slanted:  Helvetica-BoldOblique

Courier Family (fixed pitch)

Standard: Courier
Slanted: Courier-Oblique
Bold: Courier-Bold

Bold Slanted: Courier-BoldOblique

3.7 Settings, Preferences or Configuration Files

CRY SCON hasin the past saved various settingsin afile, SCRPTR, whichisin the same
folder or directory asthe CRY SCON program or executablefile. SCRPTR saves general
settings which may be used for al data, such asframe sizesfor printing and graphicsfile
output and is always saved before exiting the program.

Starting with V2.1, thisinformation is saved in astandard type of filewhich is specificto
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the platform (Windows, Mac or Linux), and thisfileisin alocation specific to each user.
Thus each user will have his or her settings preserved, even if only one copy of the

CRY SCON folder/directory and executablefileis present. Further, these settingswill be
carried on as new versions of CRY SCON areinstalled.

Specifically the new settingsfileswill beinthefollowing locations:

Windows: \Documents and Settings\username\CRY SCON.ini

Macintosh: :Users.username:Library:Preferences:CRY SCON Preferences
Linux: /home/username/.CRY SCON (note the period - thisisahidden file)
where username is the name of the current user logged in.

The SCRPTR file still exists. On startup, CRY SCON looksfirst for the user-specificfile,
and if thisisnot present it reads the values from the SCRPTR filein the folder or
directory containing the CRY SCON executablefile. Thereafter the user-specificfileis
written and used.

The Windows and Linux versions have separate Help server programs, and these write
their own user-specific preferencesfiles. Thesefileswill bein the abovelocations, and
the program nameis"wxHTMLHelpController" instead of "CRY SCON". Inthe
Macintosh version, there is no separate Help server program and the data for the Help
windows (window sizes and location and fonts) isin the CRY SCON Preferencesfile.

In the Settings menu, there are now optionsto read and write the "archive" SCRPTR file
- thiswrites the values currently used by CRY SCON. If there are multiple users of

CRY SCON, the SCRPTR file should probably be written only the the system
administrator. All users may read thefilesto get the "standard" or archive values.
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